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In This Guide ...

In This Guide ...

This guide contains installation and reference information for ChemStation 
OpenLAB Option G2189BA, the ECM interface between Agilent ChemStation 
and an Agilent Enterprise Content Manager (ECM) client/server system.

1 Introduction

This chapter introduces ECM, the implementation of OpenLAB Option in 
ChemStation, and the requirements of 21 CFR Part 11.

2 Installation

This chapter describes the installation and configuration of ChemStation 
OpenLAB Option.

3 Basic Concepts of ChemStation OpenLAB Option

This chapter describes how to log in to ECM in ChemStation, and explains the 
ECM-related user interface items and toolbars, as well as the main preference 
settings.

4 Working With ChemStation OpenLAB Option

This chapter describes the basic workflows with ChemStation OpenLAB 
Option. There are four data-related workflows and two workflows for methods 
and sequence templates.

5 Administration Regarding 21 CFR Part 11 Compliance

This chapter explains the purpose of 21 CFR Part 11 and its implementation in 
ChemStation with ChemStation OpenLAB Option.

6 Custom Fields

This chapter explains the purpose and usage of custom fields in ChemStation.
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7 Treatment of ChemStation Legacy Data and Data Migrated from ChemStore

This chapter provides information on migrating legacy ChemStation sequence 
data to sequence container format, in order to be able to upload these data 
sets to ECM.

8 Interface to OpenLab Intelligence Reporter

This chapter provides information on the integration of OpenLAB Intelligence 
Reporter in Agilent ChemStation.

9 Attribute Extraction Services for ChemStation Data

This chapter provides an overview of the available ECM Attribute Extraction 
Services (AES) for ChemStation data. The AES extract metadata information 
from the ChemStation data files. These metadata make the ChemStation data 
searchable. For detailed information, refer to the ECM documentation.

10 Using Print Services in ChemStation

This chapter gives a brief overview of how to install and configure the Print 
Services. This enables you to automatically upload ChemStation reports to 
ECM in a PDF format.

11 Troubleshooting

The chapter gives some elementary troubleshooting hints.

12 Appendix



ChemStation OpenLAB Option Concepts Guide 5

Contents

Contents

1 Introduction 9

What is ECM? 10
Add-On Solution for ChemStation: OpenLAB Option 11
Data Storage in ECM 16
21 CFR Part 11 Compliance 17

2 Installation 19

Prerequisites 20
Compatibility 21
Installation and Configuration Tasks on ECM Server 22
Installation Tasks on the ChemStation Computer 27
Uninstallation 36

3 Basic Concepts of ChemStation OpenLAB Option 37

User Permissions 38
OpenLAB Option User Interface in ChemStation 41
ECM Preferences 44
Remote Data Path as Sequence Parameters 54
Compressed ChemStation File Formats 56

4 Working With ChemStation OpenLAB Option 57

Transferring Data to or from ECM 58
Data-related workflows 59
Workflows for Methods and Sequence Templates 70

5 Administration Regarding 21 CFR Part 11 Compliance 79

Introduction to 21 CFR Part 11 80
Overview of Configuration Steps Required for Part 11 83
Audit Trails and Logbooks 84
Administration in ECM 89
Administration of ChemStation Settings 92
Electronic Signature 95



6 ChemStation OpenLAB Option Concepts Guide

Contents

6 Custom Fields 99

About Custom Fields 100
Setting Up Custom Fields 101
Specifying Custom Fields Values 103
Reporting of Custom Fields 105
Reprocessing with Custom Fields 107

7 Treatment of ChemStation Legacy Data and Data Migrated from 
ChemStore 109

Introduction 110
Sequence Container Migration 111
Conversion of Data Migrated from ChemStore 113

8 Interface to OpenLab Intelligence Reporter 115

Introduction 116
Interface Components Concerning OpenLAB IR 124

9 Attribute Extraction Services for ChemStation Data 127

Attribute Extraction Services for ChemStation Data 128
ACAML Filter 131
ChemStation XML Attribute Extraction Service 132
ChemStation Filter 133

10 Using Print Services in ChemStation 135

ECM Print Services 136
Setting Up ECM Print Services 137
Configuring ECM Print Services for use with Amyuni PDF Converter 138
Configuring ECM Print Services - Adobe Distiller 140
Working with ECM Print Services in ChemStation 142

11 Troubleshooting 143

General Problems 144
Alerts and Error Messages at ChemStation Startup 145
Error Messages in the Spooler Queue Manager 146



ChemStation OpenLAB Option Concepts Guide 7

Contents

12 Appendix 149

ChemStation Privileges in ECM 150
ChemStation Roles in ECM 153
ECM related privileges concerning the ChemStation configuration 157



8 ChemStation OpenLAB Option Concepts Guide

Contents



9

ChemStation OpenLAB Option Concepts Guide

Agilent Technologies

1
Introduction

What is ECM? 10

Add-On Solution for ChemStation: OpenLAB Option 11

Overview of data-related workflows 12

Overview of workflows for methods/sequence templates 14

Data Storage in ECM 16

21 CFR Part 11 Compliance 17

This chapter introduces ECM, the implementation of OpenLAB Option in 
ChemStation, and the requirements of 21 CFR Part 11.
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1 Introduction
What is ECM?

What is ECM?

The Agilent Enterprise Content Manager (ECM) is a web-based electronic 
library that allows you to safely archive and catalog any electronic file. ECM 
allows you to store and index analytical raw data, reports, and all other types 
of documents. The stored files can be shared with other users. 

You can store any electronic file type, such as Microsoft Office documents, 
Adobe PDF documents, images, and molecular drawings, as well as raw data 
and reports generated by ChemStation.

ECM allows you to easily collect, organize, search, and review all of your data. 
It automatically extracts searchable metadata from files, and provides 
powerful search capabilities. In addition, ECM provides embedded viewers for 
many file types.

The ECM interface is opened via Microsoft Internet Explorer, also referred to 
as the ECM Web Client.
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Add-On Solution for ChemStation: OpenLAB Option

Starting with revision B.02.01 SR1, Agilent ChemStation provides an interface 
to the Agilent Enterprise Content Manager (ECM), which enables you to store 
analytical data and reports in a secure location. From ChemStation, you can 
log in to ECM and store methods, sequence templates, data files, and reports 
in ECM. Data storage can be either automatic (that is, at the end of a single 
run or sequence) or manual. ChemStation data stored in ECM can later be 
downloaded to ChemStation for review or reprocessing at any time.

Furthermore, ChemStation OpenLAB Option offers features that enable users 
to comply with 21 CFR Part 11 and similar regulations for electronic records 
and electronic signatures:

• Mandatory login/connection to ECM

• Configurable session locking

• Configurable ChemStation user roles and privileges

• Full data traceability through audit trails for methods and results

• Full data versioning

ChemStation OpenLAB Option requires the following components:

• ECM Server

• ChemStation OpenLAB Option installed on the ECM Server

• ECM Web Client installed on the ChemStation computer

• ChemStation with ChemStation OpenLAB Option installed on the 
ChemStation computer

• Connection between the ChemStation computer and the ECM Server

The main workflows for the transfer of raw data and methods/sequence 
templates are listed below. These workflows indicate the system activities in 
relation to the work processes.
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Overview of data-related workflows

Workflow 1: Raw data acquisition and automatic transfer to ECM 

1 Analytical raw data is acquired using ChemStation.

2 The raw data is automatically uploaded to ECM using the configured path 
definitions immediately after the single run/sequence is finished.

3 A new ECM data set is created in the defined ECM location.
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Workflow 2: Offline revision during acquisition

1 Analytical raw data is acquired using ChemStation.

2 While the acquisition is still running, part of the data is changed using an 
offline ChemStation.

3 The raw data is automatically uploaded to ECM using the configured path 
definitions immediately after the single run/sequence is finished.

A new ECM data set is created in the defined ECM location.

4 After work in the offline ChemStation is finished, the changed data is also 
automatically uploaded to ECM.

Another new version of the ECM data set is created.

Workflow 3: Reprocessing data and automatic upload to ECM

1 Existing analytical data is loaded from ECM into ChemStation.

2 The data is reprocessed in ChemStation.

3 The data is automatically uploaded to ECM. The location in ECM is defined 
by the original path definitions of the downloaded ECM data.

4 A new version of the data is created in ECM.

Workflow 4: Import after reprocessing

1 Existing analytical data is opened locally.

2 The data is reprocessed in ChemStation.

3 After reprocessing, the data is automatically uploaded to ECM. The location 
in ECM is defined by the current preferences in ChemStation.

4 A new version of the data is created in ECM.

For more details, and for additional workflows, refer to “Data-related 
workflows” on page 59
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Overview of workflows for methods/sequence templates

Workflow 1: Uploading a new method

1 A new method or sequence template is created.

2 The method or sequence template is uploaded to ECM using the path 
selected by the user.

3 The version 1 of the method or sequence template is automatically created 
in ECM.
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Workflow 2: Saving a changed method

1 An existing method or sequence template is loaded from ECM.

2 The changed method or sequence template is saved to ECM.

3 A new version of the method or sequence template is automatically created 
in ECM.

For more details, and for additional workflows, refer to “Workflows for 
Methods and Sequence Templates” on page 70
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Data Storage in ECM

Data Storage in ECM

ECM provides a four-level data storage model with the structure of Location, 
Cabinet, Drawer, Folder. The Location, Cabinet, Drawer and Folder names 
comprise the path name (called either LCDF path or Remote Data Path) of the 
storage location. Data is stored at Folder level only. 

The ECM program’s content structure is similar to rooms filled with file 
cabinets. Each cabinet has multiple drawers, which then contain hanging 
folders. Finally, paper files are stored in the folders. The LCDF structure can 
be created using the ECM Web Client. In addition, it is possible to create 
additional Locations, Cabinets, Drawers, and Folders using the ChemStation 
Remote Data Path. In ChemStation, it is also possible to set predefined tokens 
for the Drawers and Folders.

In the ECM tree view, locations are denoted by a house icon. Inside each 
Location, Cabinets are denoted by the file cabinet icon. Inside each Cabinet, 
Drawers are denoted by the drawer icon. Finally, inside each Drawer, Folders 
are denoted by the folder icon. The entire content structure appears in the 
Content book.

Figure 1 LCDF structure in ECM

Uploaded objects can be stored in the lowest (i.e. Folder) level only. It is not 
possible to upload data to other levels of the hierarchy.
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21 CFR Part 11 Compliance

Effective August 20, 1997, the U.S. Food and Drug Administration (FDA) 
released and published a new rule to enable pharmaceutical companies to 
approve their results with electronic signatures and to transfer paper-trail 
documentation into electronic records. This rule is known as 21 Code of 
Federal Regulations Part 11 (referred to as 21 CFR Part 11) and applies to all 
industry segments regulated by the FDA.

21 CFR Part 11 includes the US Federal guidelines for storing and protecting 
electronic records and applying electronic signatures. The intent of these 
guidelines is to ensure that electronic records subject to these guidelines are 
reliable, authentic, and maintained with high integrity.

ChemStation OpenLAB Option with ChemStation B.04.xx provides the 
necessary controls for managing system access, audit trail functions, 
versioning of ChemStation data, and electronic signature functions. Agilent 
OpenLAB ECM ensures secure record keeping and data archival. Agilent 
OpenLAB ECM is proven and has been deployed at many leading life sciences 
companies to satisfy compliance mandates for 21 CFR Part 11.
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This chapter describes the installation and configuration of ChemStation 
OpenLAB Option.
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2 Installation
Prerequisites

Prerequisites

Before you install Agilent ChemStation OpenLAB Option, make sure that the 
following prerequisites are met:

• The ECM Server software must be installed and configured as described in 
the Enterprise Content Manager Installation Guide. All server-related 
prerequisites, as well as the installation and configuration details, are 
described in the guide.

The ECM versions supported with ChemStation are:

• OpenLAB ECM Workgroup 3.3.1 - MS SQL Server 2005, with ECM 3.3.1 
Hotfixes 1-5, 

• OpenLAB ECM Enterprise with ECM 3.3.1 Hotfixes 31, 45, 47-54, 56-57, 
59, and 70,

• OpenLAB ECM Workgroup 3.3.2 SP1 - MS SQL Server 2005,

• OpenLAB ECM Enterprise 3.3.2 SP1 - MS SQL Server 2005, or

• OpenLAB ECM Enterprise 3.3.2 SP1 - Oracle 10.2.0.1 or Oracle database 
server 10.2.0.4 with Oracle client 10.2.0.1

• Ensure that the minimum PC and operating requirements are met for 
ChemStation. Details can be found in the Installing your ChemStation 
manual for your respective instrument.

• Setting up the connection from ChemStation to the ECM Server requires 
the address of the ECM Server.
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Compatibility

ChemStation Add-Ons

ChemStation OpenLAB Option is not supported in combination with the 
following ChemStation Add-Ons and features:

• ChemStore / Security Pack

• Purify

• Easy Access

• ChemStation Unique Folder Creation OFF (item is not accessible)
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Installation and Configuration Tasks on ECM Server

You must execute the database script for ChemStation privileges on the ECM 
Server to implement ChemStation related users, roles and privileges within 
OpenLAB ECM. In addition, after installing the program, you must take care of 
several ECM settings.

Updating the ECM Database

A database script is provided on the ChemStation DVD that creates specific 
ChemStation privileges and ChemStation roles in ECM. The procedure 
depends on the ECM Database type (Oracle or SQLServer).

Prerequisites

You need the login data of the following users:

• A Windows user who can connect to the ECM Database.

• An ECM Database user who is authorized to access the ECM schema and to 
update the tables in this schema.

To update an Oracle ECM Database

1 Log on to a Windows computer that has SQLPlus installed.

2 Insert the ChemStation DVD in your DVD drive. Navigate to the folder 
ECM-DatabaseScript\Oracle.

3 If you have the password for the database user SYS, execute InstallOracle.cmd. 
Otherwise, execute InstallOracleNonSYS.cmd.

A command window opens.

4 You are prompted to enter several parameters. Type in the required data 
and press Enter to confirm each entry: 

• Database name (host string): The host string for your ECM Database.

• User name: A user name is only requested if you executed 
InstallOracleNonSYS.cmd.
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• Path and filename of the log file: An installation log file is created in the 
given location.

• Password for database user: The password is not shown while typing.

• Schema/user name for ECM

• Directories where the data files, index files, and map files of the new 
database schema should be stored.

5 Review the data. 

• If something is wrong: press Ctrl+C to abort the installation.

6 If everything is OK: Press Enter.

The installation begins. When the installation is finished, the text Installation 
finished is shown in the command window.

7 Press any key to close the command window.

8 Check the installation log file. It should only include messages about 
changing the database, no warnings or errors.

To update an SQLServer ECM Database

1 Log on to a client that has SQLCmd installed.

2 Insert the ChemStation DVD in your CD-ROM drive. Navigate to the folder 
EMC-DatabaseScript\SQLServer.

3 If you have the password for the database user SA, execute InstallSQL.cmd. 
Otherwise, execute InstallSQLNonSA.cmd.

A command window opens.

4 You are prompted to enter several parameters. Type in the required data 
and press Enter to confirm each entry: 

• ECM Database Server: Server name of the ECM Database Server.

• ECM Database Name

• Database User Name: Normally: 
CYBERLABLOGIN

• Directory and Name for log file: An installation log file is created in the given 
location.

5 Review the data. 

• If something is wrong: press Ctrl+C to abort the installation.
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6 If everything is OK: Enter the password for the database user you provided 
before.

The installation begins. When the installation is finished, the text Installation 
finished is shown in the command window.

7 Press any key to close the command window.

8 Check the installation log file. It should only include messages about 
changing the database, no warnings or errors.

Updating roles in existing ECM Accounts

When updating the ECM Database, certain specific ChemStation roles and 
privileges have been created. If you create a new ECM Account, these roles 
their privileges are automatically available in that new account. However, if 
you want to use ChemStation OpenLAB Option with an existing ECM Account, 
you must first update the roles in that specific account. The new ChemStation 
roles and their privileges will be available only after updating the roles for the 
existing account.

To make the new roles and privileges available in an ECM Account

1 Open a browser window and connect to the ECM Web Server.

2 Log in to the ECM Account in which you want to update the roles.

3 Select the Administration tab.

4 Click Account Administration.

5 Double-click Users / Groups / Roles.

The Account Administration dialog opens.

6 Select the Roles tab.

7 Click Reset Roles.

NOTE All system roles will be reset to default when performing Reset Role. If you made manual 
changes to a system role, these changes will be lost!

All other roles that were created manually will be deleted!
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The default ChemStation roles and the according ChemStation privileges 
(see “ChemStation Roles in ECM” on page 153) are now available in the 
current account and can be assigned to the users.

Configuring users, roles and privileges

Concept of users, roles, and privileges

In ECM, you can either create specific ECM users or operate with the Windows 
users. Each user can be member of a specific group. The available groups 
depend on the ECM configuration. 

You must assign a specific ECM role to each group. You can also assign roles to 
single users, however, for the sake of clarity, it is strongly recommended to 
assign roles only on the group level. 

The roles are equipped with numerous specific privileges, which define what 
the users are allowed to view or do in ECM and in ChemStation. 

Default roles and privileges

There are a number of default roles and privileges in ECM that are created 
during the installation of ECM and ChemStation OpenLAB Option. The 
following tables show an overview of these roles and privileges.

NOTE The default ChemStation roles do not contain any ECM privileges! A ChemStation user who 
wants to access ECM must additionally be assigned the required ECM roles (see 
“Assigning roles” on page 26 and “ECM related privileges concerning the ChemStation 
configuration” on page 157).

NOTE Once you created a new ECM user, group, or role, you can not delete it again. You can only 
deactivate the unused item.

Name Description

• Starting with “:CS” Default ChemStation role.
Can be restored by the Reset Roles function.

• Starting with “:” Default ECM role. Can be restored by the Reset Roles function.
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In addition, you can create your own roles in ECM, or grant further privileges 
to the default roles. For detailed information, refer to the ECM 
Administrator’s Guide.

Assigning roles

Users do not need any specific role in order to log in to ECM. However, in 
order for users to see a particular Location, Cabinet, Drawer, or Folder in the 
user interface, they must have the :Reader role as a minimum requirement. As 
a result, domain users with no global roles might not be able to view anything 
in the content unless they were granted the appropriate privileges.

You should grant the users of the ChemStation OpenLAB Option the 
:Contributor role. This can be done at the global level for the entire ECM 
Account, or individually for specific folders (see “Roles and folders” on 
page 91). The :Contributor role allows the ChemStation OpenLAB Option user to 
view and add content to ECM. The :Contributor role should be enhanced with 
the Content: Add Folder privilege. This allows ChemStation ECM users to add 
folders to the LCDF hierarchy.

In addition to the ECM roles, user of ChemStation OpenLAB Option must be 
assigned at least one of the ChemStation roles or another, customized role 
with according ChemStation privileges. You find a complete list of all 
ChemStation roles and all relevant privileges in the Appendix.

Name Description

• Starting with “CS:” Privilege related to ChemStation
For details on the ChemStation privileges, see “Appendix” on 
page 149.

• Starting with “Content:” Privilege related to ECM

• Starting with “System:” Privilege related to ECM

NOTE If the role does not include the Add Folder privilege, the users cannot add a new Remote 
Data Path (LCDF) in ChemStation.

NOTE If a ChemStation user has no ChemStation privileges in ECM, this user is not able to work 
with ChemStation OpenLAB Option!
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Installation Tasks on the ChemStation Computer

ChemStation OpenLAB Option (G2189BA) is a separate installation package 
delivered on the ChemStation DVD. It can be initially installed with the 
ChemStation software, or added to an existing ChemStation. After 
installation, ChemStation OpenLAB Option is available for all ChemStation 
instances installed on the particular client PC.
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Preparing the ECM Web Client

To prepare the ECM Web Client

1 On the ChemStation computer: Open a browser window and connect to the 
ECM Web Server.

2 Log in to ECM.

All relevant hotfixes are automatically installed. You may be asked to 
restart the ChemStation computer during the installation.

Installing a new ChemStation with ChemStation OpenLAB Option

Before installing the software, verify that all prerequisites are met (see 
“Prerequisites” on page 20).

The installation is divided in the following steps:

• Installing the ECM API

• Installing ChemStation

• Adding instruments

• Providing license keys

• Configuring instruments

To install the ECM API

1 Insert the ChemStation DVD into the DVD drive.

2 In Windows Explorer, navigate to the folder [diskdrive]:\ECMAPI and 
double-click the file ECMAPIDeploy.mci.

The Agilent OpenLAB ECM API Installation wizard Opens.

3 Click Next.

Preparations You need to make sure there is an up-to-date version of the ECM Web Client installed on the 
ChemStation computer. 

NOTE If you use Windows Vista: Make sure the User Account Control feature is disabled before 
you connect to ECM!
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4 Enter User Name and Organization. Select the option to install the API for 
“Anyone who uses this computer (all users)”. Click Next.

5 Select a destination folder where you want to install the ECM API (the 
default folder is C:\Program Files\Agilent Technologies\ECM API\1.0.24.1). Click 
Next.

6 Click Install.

7 After the installation has completed, click Finish.

To install ChemStation

1 Insert the ChemStation DVD into the DVD drive.

2 From the Start menu in the Task Bar, select Start > Run.

3 At the command line, type 
[diskdrive]:\Setup For example: D:\Setup

The setup software checks if the following software components are 
available:

• Microsoft .NET Framework 3.5 SP1

• PDF-XChange 4.0

4 If there are missing components, additional dialogs open to install these 
components. Click Install to install the missing components. For the 
Microsoft .NET Framework also read and agree to the License Agreement.

After the missing components have been installed, the Agilent ChemStation 
Setup Wizard opens.

5 Click Next.

6 Select the check box to confirm the license agreement. Click Next.

7 Select a destination folder where you want to install the new ChemStation 
(the default folder is C:\Chem32). Click Next.

8 Click Install. 

ChemStation is now being installed. This can take several minutes.

9 Click Finish.

The Setup Wizard - Instruments dialog opens. Proceed now with adding the 
instruments.
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To add instruments

1 In the Setup Wizard - Instruments dialog, click the Add buttons to add the 
required instruments. 

Figure 2 Setup Wizard - Instruments

2 Under General Addon products, select the ChemStation OpenLAB Option check 
box. 

3 Click Next.

The Setup Wizard - Licenses dialog opens.

4 Proceed now with providing the license keys.

To provide license keys

1 In the Setup Wizard - Licenses dialog, enter a valid license key for 
ChemStation OpenLAB Option in the input field at the bottom. 

NOTE The applicable license product and license numbers are printed on your Software 
Certificate and Registration Packet.
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2 Click Add to add the license key to the list. 

3 Provide valid license keys accordingly for all of the instruments shown in 
the list.

The software automatically recognizes which license is valid for which 
module.

4 Click Next.

The ChemStation Administration Tool dialog opens.

Figure 3 ChemStation Administration Tool

NOTE Note that any Windows user with administrative privileges can remove the G2189BA 
OpenLAB Option license and thus disable OpenLAB Option functionality from the 
ChemStation. It is therefore recommended that in an regulated environment ChemStation 
users work as Windows Users or Powerusers.
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5 Select or clear the Mandatory Login check box, depending on whether the 
ECM login should be mandatory or optional in ChemStation (the settings 
will be used for all ChemStation instances that are installed on this 
computer). For more details on the login functions see “User 
Permissions” on page 38.

6 Click OK.

7 Click Finish.

The Configuration Editor opens.

8 Proceed now with configuring the instruments.

To configure instruments

You can configure the instruments in the Configuration Editor. For details see 
the manual Installing your ChemStation.

After the successful installation, ChemStation contains the new ECM menu 
and a number of other ECM interface elements (see “Overview of new 
interface elements” on page 41.

Adding ChemStation OpenLAB Option to an existing ChemStation 

To add ChemStation OpenLAB Option subsequently

1 From the Start menu in the Task Bar, select Start > All Programs > Agilent 
ChemStation > Add instrument.

The Setup Wizard - Instruments dialog opens (see Figure 2 on page 30).

2 Under General Addon products, select the ChemStation OpenLAB Option check 
box. 

3 Click Next.

The Setup Wizard - Licenses dialog opens. 

NOTE You do not need to configure the other options in this dialog during the installation. You can 
configure these items anytime in ChemStation (see “ECM Preferences” on page 44 and 
“Audit Trails and Logbooks” on page 84) or by using the ChemStation Administration Tool 
directly (see “ChemStation Administration Tool” on page 92).
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4 Enter a valid license key for ChemStation OpenLAB Option in the input 
field at the bottom. 

5 Click Add to add the license key to the list. 

6 Click Next.

The ChemStation Administration Tool dialog opens (see Figure 3 on page 31).

7 Select or clear the check box Mandatory Login, depending on whether the 
ECM login should be mandatory or optional in all ChemStation instances 
on this computer.

8 Click OK.

9 Click Finish.

The Configuration Editor opens. As you have already configured the 
instruments, and have now added the OpenLAB Option, you can exit the 
Configuration Editor without any further actions.

10 Prepare the ECM Web Client and install the ECM API as described in 
“Preparing the ECM Web Client” on page 28.

Enabling users to start the ChemStation Administration Tool

The ChemStation Administration Tool is automatically installed as a part of 
ChemStation OpenLAB Option during the procedure described above. 

The ChemStation Administration Tool offers you to change the transfer 
settings (see “Automatic Data Transfer Settings” on page 47) for all 
ChemStation instances on a computer in a single step. In addition, there are a 
number of functions which are helpful if the connection from the ChemStation 
client to the ECM Server is lost. As one of these functions is to switch off the 
mandatory ECM login, access to the ChemStation Administration Tool must be 
strictly limited.

During the Installation of ChemStation OpenLAB Option, the local user group 
CSAdministrators is automatically created. Only members of this group are 
allowed to run the ChemStation Administration Tool. The user who installs 
ChemStation, is automatically added to the CSAdministrators group. 
Additionally, the Windows group Administrators and the user who installs 
ChemStation are granted Full Control privileges on the Administration Tool 
program executable (Agilent.ChemStation.ECM.ECMAdmin.exe) itself, thus 
they are able to run the tool.
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To add a Windows user to the CSAdministrators group:

1 From the Start menu in the Task Bar, select Start > Settings > Control Panel > 
Administrative Tools > Computer Management.

The Computer Management window opens.

Figure 4 Computer Management window

2 Right-click the group CSAdministrator and select Add to Group... from the 
context menu.

The Properties dialog shows the users who are currently member of the 
group.

NOTE See “Administration of ChemStation Settings” on page 92 for more details on the 
ChemStation Administration Tool.
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3 Use the Add button to add the required users.

After confirming with OK, the Properties dialog also contains the newly 
added users.
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Uninstallation

To uninstall Agilent ChemStation

Windows XP:

1 From the Start menu in the Task Bar, select Start > Settings > Control Panel > 
Add or Remove Programs. 

2 Select the Agilent ChemStation program and click Remove.

3 When asked for confirmation, click Yes.

To uninstall Agilent ChemStation

Windows Vista:

1 From the Start menu in the Task Bar, select Start > Control Panel > 
Programs > Programs and Features. 

2 Select the Agilent ChemStation program and click Uninstall.

3 When asked for confirmation, click Yes.

The program is uninstalled. All files of the ChemStation folder (by default: 
C:\chem32) are removed. Only files that have been modified by the user (for 
example, methods, sequence templates, or data files) are not deleted.

To uninstall other ChemStation components

During the installation of ChemStation, a few additional components were 
installed. You can remove these components using the Add or Remove Programs 
function, with which you can also remove ChemStation.

The following components may have been installed together with 
ChemStation:

• PDF-XChange 4.0

• Microsoft .NET Framework 3.5 SP1
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This chapter describes how to log in to ECM in ChemStation, and explains the 
ECM-related user interface items and toolbars, as well as the main preference 
settings.
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User Permissions

Log In/Log Out

To prevent unauthorized access to ECM or unauthorized use of ChemStation 
OpenLAB Option, ECM requires authentication with a user name and 
password. In addition, each user needs user privileges defining the accessible 
content. 

The user administration is set up and managed on the ECM Server. For more 
details about login and user setup refer to the ECM User/Administrator's 
Guide.

Optional or mandatory

Depending on the configuration during the installation of ChemStation, the 
ECM login can be optional or mandatory. If it is mandatory, you must log in to 
ECM during the ChemStation startup. If it is optional, you can initially skip 
the login and then log in to ECM later. 

If you are already logged in to ECM server in the online instrument session 
and start the offline session via the item Reprocessing Copy from the View 
menu, the user will be automatically connected to ECM with the same login 
information (silent login).

If you are not connected to ECM, all of the ECM functions are grayed out.

You can log in to ECM from the following ChemStation views:

• Method and Run Control

• Data Analysis

Once you have logged in to ECM, it is possible to upload data to ECM and 
simultaneously work on the local ChemStation file system.

The login is dependent on the instrument session; only one user can be logged 
in to ECM at any one time. If another user wants to log in, you must first log 
out.
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User credentials

The Login dialog requires you to enter a set of valid authorization details in 
order to log in to ECM. The login information is ECM Server-specific and will 
be provided by the ECM administrator.

You need to enter the following login details:

• Server URL: the URL of the ECM Server

• Account: you can store content to the locations assigned in the specific 
account; one ECM Server may have several accounts.

• Username: the user name defined in the ECM Account, or your NT domain 
user name (depending on the user configuration in ECM)

• Password: the password provided by your administrator, which can be 
changed on request (for ECM ‘built-in’ users), or the password of your NT 
domain account, if you are logging in using your NT domain user name.

• Log on to: the domain administrating the ECM users

ChemStation Operator and ECM User

If you log in to ECM and have been authorized by the ECM system, the 
ChemStation operator name in the sample info (when running single samples) 
or the sequence parameters (when running a sequence) is overwritten by your 
ECM user name. 

As long a user is logged on to ECM, the operator name is given by the ECM 
logon and cannot be overwritten. As soon as you log out of ECM, the 
ChemStation operator name defined by the ECM is removed, and is replaced 
by the entry “disconnected”. While acquiring data to ECM, it is not possible 
either to log in or to log out of ECM. This prevents the operator name from 
being changed during data acquisition.
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Session lock

If you leave the ChemStation computer for a certain period of time, you can 
lock ChemStation so that no other user can access the program. This is a 
safety feature to ensure that there is no unauthorized access to ChemStation. 
When you activate the session lock, you or another user must first provide a 
valid ECM login before continuing to work with ChemStation.

There are the following options to activate the session lock:

• Privately (ECM > Lock Session > privately): Only the user who activated the 
session lock, or a user with the CS: Break Session Lock privilege, can log in.

• Non privately (ECM > Lock Session > non privately): Any valid ECM user can 
log in. This is useful, for example, if there is a shift change, and the leaving 
personnel secures ChemStation until the personnel of the new shift starts 
work.

• Toolbar Lock Button: The toolbar lock button can be configured to lock the 
ChemStation session privately or non privately (see “Login options” on 
page 93).

• Time based: Depending on the ECM Account configuration, ChemStation is 
automatically locked after a given period of time without any user 
interaction (see Inactivity Timeout under “Administration in ECM” on 
page 89). If there is no activity in an ECM Web Client, the ECM Web Client is 
also locked after the given period of time. ChemStation and ECM Web Client 
are locked independently from each other. 

The time based session lock can be configured to lock the ChemStation 
session either privately or non privately (see “Login options” on page 93).
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OpenLAB Option User Interface in ChemStation

Overview of new interface elements

With the installation of ChemStation OpenLAB Option, the following new 
menus, menu items, and interface elements are available:

Menu New elements Description

Method New command
• Enable Audit Trail

See “Method Audit Trail” on page 84

Sequence > Sequence Parameters, 
Sequence Parameters tab

New fields on the Sequence 
Parameters tab:
• Remote Data Path

See “Remote Data Path as Sequence 
Parameters” on page 54

Sequence > Sequence Parameters, 
Sequence Output tab

New fields on the Sequence Output tab:
• OpenLAB Intelligence Reporter 

Template

See “Template selection in Sequence 
Output” on page 124

Report New command
• Report History

See “Report History” on page 86

View > Preferences New tabs in the Preferences dialog:
• Transfer Settings
• Audit Trail

See “ECM Preferences” on page 44 and 
“Audit Trails and Logbooks” on page 84

ECM Completely new menu See “The ECM menu” on page 42

Toolbar (depending on the current 
view)

• Shortcuts to several commands of 
the ECM menu

• LCDF info

• LCDF info in the Data Analysis view: 
shows the LCDF path of a file that has 
been stored to ECM.

• LCDF info in the Method and Run 
Control view: drop down list showing 
the last ten LCDF paths as defined in 
the Preferences if the automatic 
upload After Acquisition is selected.
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The ECM menu

The ECM menu and its commands depend on the view that is currently active. 
See the following table for details.

ECM related details in the System 
Diagram in Method and Run Control 
view (classic UI only).

Completely new details view The following details are available:
• LCDF
• Operator
• Automatic transfer after acquisition
• Automatic transfer after 

reprocessing
• Automatic transfer after any data 

modification
• Automatic import after reprocessing
• Calculate peak performance

Menu New elements Description

NOTE There is no ECM menu in the Report Layout,  Verification (OQ/PV), or Diagnosis view.

Command Description Available in ChemStation views

User-related commands:

Log In ...

Log out

Change User ...

Lock Session

See “User Permissions” on page 38 and “Session 
lock” on page 40.

• Method and Run Control
• Data Analysis

Update-commands:
Update Methods ...
Update Sequences Templates ...

Update all methods/sequence templates that are 
stored in the local file system with the current 
version from ECM (if existing in ECM). Local 
changes are overwritten.

• Method and Run Control
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Cleanup Data The Cleanup Data command deletes all data or 
sequence containers from the local file system 
that exist in ECM as well. Make sure you uploaded 
the latest version to ECM before you confirm this 
command. See “Cleanup Data on Shutdown” on 
page 49.

• Data Analysis

Manage Queue With the Manage Queue command you can 
continue any interrupted data upload to ECM. See 
“Manage Queue on Connect” on page 49.

• Method and Run Control
• Data Analysis

 Preferences
See “ECM Preferences” on page 44 for more 
details on the Preferences dialog.

• Method and Run Control
• Data Analysis

Method-related commands:

 Load Method ...

 Save Method

See “Workflows for Methods and Sequence 
Templates” on page 70

• Method and Run Control
• Data Analysis

Data-related commands:

 Load Data ...

 Save Data

Save Data As ...

See “Data-related workflows” on page 59 • Data Analysis

Commands related to the sequence 
template:

 Load Sequence Template ...

 Save Sequence Template

See “Workflows for Methods and Sequence 
Templates” on page 70

• Method and Run Control

Commands related to OpenLAB 
Intelligence Reporter:

 Start OpenLAB IR

 Create OpenLAB IR Report

See “Interface Components Concerning OpenLAB 
IR” on page 124

• Data Analysis

Command Description Available in ChemStation views
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ECM Preferences 

The Preferences dialog contains two tabs that are relevant to ChemStation 
OpenLAB Option: the Transfer Settings tab and the  Audit Trail tab.

On the Transfer Settings tab, you must specify the following preferences in order 
to automatically store ChemStation data to ECM:

• Remote Data Path

• Automatic Data Transfer Settings

• Transfer Management Settings

Figure 5 Transfer Settings tab in the Preferences dialog

All of these items can be specified independently for each instrument. Offline 
and online sessions are automatically synchronized. 

NOTE Several settings in the Transfer Settings tab and the  Audit Trail tab may have been 
specified for all ChemStation instances on the computer via the ChemStation 
Administration Tool (see “ChemStation Administration Tool” on page 92). In this case, you 
cannot change the settings in the Preferences dialog.
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On the Audit Trail tab, you can enable the Method Audit Trail and Results Audit 
Trail. For details on audit trails see “Audit Trails and Logbooks” on page 84.

Figure 6 Audit Trail tab in the Preferences dialog

Remote Data Path

In ChemStation OpenLAB Option, the Remote Data Path needs to be specified in 
order to save the data to the correct location in ECM. 

In the Preferences dialog, the Transfer Settings tab (see Figure 6 on page 45) 
allows you to define the Remote Data Path. The Remote Data Path reflects the 
LCDF structure in ECM.

Server/Account

In the text fields Server and  Account, you can specify the ECM Server and ECM 
Account that you want to use to store the ChemStation data.

NOTE You can change these settings for all ChemStation instances on the client PC in one single 
step by using the ChemStation Administration Tool (see “ChemStation Administration 
Tool” on page 92).
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At your first login from ChemStation to ECM, you must specify the server and 
account information. You can either enter the information manually, or you 
can click Get Server to fill the fields with the Server and Account where you are 
currently logged in. ChemStation then keeps the Server and Account 
information for future sessions.

If you log in to a different ECM Server later, you have to update the Server and 
Account information. You can click Get Server again to fill the fields with the 
current ECM Server name and the current ECM Account.

Path

To specify the Remote Data Path, you need to select a Location and Cabinet 
available in the ECM Browser. Click Select Path to select the required path in 
an ECM Explorer dialog.

For the Drawer and Folder, you can either keep the selected items, or you can 
select predefined tokens for an automatic path creation. When you use the 
predefined tokens in the Remote Data Path, the system automatically creates 
the items if they do not already exist in ECM.

Alternatively, the Remote Data Path can be specified as Sequence Parameter (see 
“Remote Data Path as Sequence Parameters” on page 54). Uploaded objects 
can be stored only at the Folder level.

NOTE If no Remote Data Path is specified, a warning message will be shown at ChemStation 
startup.

NOTE If you use tokens, make sure you have the required ECM privileges to create folders! 
Alternatively, another user who has the required privileges can create the necessary folders 
in advance.
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Automatic Data Transfer Settings

In the Preferences dialog (View > Preferences), the ECM tab allows you to specify 
the automatic settings for the transfer of raw data. The transfer settings, as 
well as the Remote Data Path, are used to automatically upload data to ECM. 

After Acquisition

If you select this check box the data is automatically uploaded to ECM after an 
acquisition. The raw data files are written to the local ChemStation file system 
while the sequence is still running. When the complete sequence is finished, 
the raw data files are compressed to an SSIZip file which is then uploaded to 
ECM. 

For more information, please refer to “Workflow 1: Acquisition and automatic 
upload” on page 59.

Table 1 Remote Data Path items

ECM Data Path Item Convention

Location Fixed location
to be selected in ECM

Cabinet Fixed cabinet
to be selected in ECM

Drawer Drawer available in ECM
Tokens: Instrument Name, Instrument Number, Operator

Folder Folder available in ECM
Tokens: Instrument Name, Instrument Number, Operator

NOTE If you are not logged in to ECM in ChemStation, the data cannot be automatically uploaded 
to ECM as specified in the transfer settings. The data is then queued in the Spooler Queue 
Manager (see “Spooler Queue Manager” on page 50).

NOTE If you perform data acquisition from the Diagnosis view or  OQ/PV view, the transfer 
settings are ignored. The analytical raw data is written to the ChemStation data file system 
as predefined in the diagnosis or verification methods.
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After Any Data Modification

If you select this check box, the sequence data container is automatically 
uploaded to ECM after you changed the data analysis parameters for a sample. 
The data is uploaded even if you do not reprocess the sequence.

For more information, please refer to “Workflow 2: Offline review during 
acquisition” on page 62.

After Reprocessing

If you select this check box, the sequence data container is automatically 
uploaded to ECM each time after you reprocessed the sequence.

For more information, please refer to “Workflow 3: Reprocessing data and 
automatic upload” on page 64.

Import after Reprocessing

If you select this check box, a sequence that is only stored locally is 
automatically uploaded to ECM after reprocessing.

For more information, please refer to “Workflow 4: Import after 
reprocessing” on page 68.

Calculate Peak Performance

This option influences the amount of transferred data. If you select this 
option, extended performance values (such as noise or system suitability) are 
always calculated, saved to ECM, and can be used in OpenLAB Intelligence 
Reporter. If the check box is cleared, the extended performance values are 
only available if you choose the ChemStation report styles Performance or 
Extended Performance.

For more information, please refer to “Calculation of performance values” on 
page 126.
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Transfer Management Settings

Manage Queue on Connect

If the connection to ECM breaks down for any reason, a running data upload 
might be interrupted. In this case, the remaining data is written to an internal 
queue. 

If you select the check box Manage Queue on Connect, ChemStation tries to 
upload the remaining data to ECM each time a connection to ECM is 
established (that is, each time a user logs on to ECM from ChemStation).

Alternatively, you can open the Spooler Queue Manager dialog (see “Spooler 
Queue Manager” on page 50) at any time with the ECM > Manage Queue 
command in the Data Analysis view.

Cleanup Data on Shutdown

If you select this check box, ChemStation checks the local file system at each 
shutdown. It deletes all local data and sequence files that are known to be 
stored in ECM as well. Methods and sequence templates remain on the local 
file system.

Alternatively, you can open the Data Cleanup dialog at any time with the ECM > 
Cleanup Data command in the Data Analysis view.

This dialog box lists all data sets related to ECM apart from the currently 
loaded data. The following columns are available:

• Directory: Location of the local file

• ECM Information: ECM server, account information, and LCDF path of the file 
in ECM

• Last Modified: Date/Time when the copy in ECM was last changed

NOTE If you select the Cleanup Data on Shutdown check box, you should also select the 
Automatic Data Transfer Settings After Acquisition, After Reprocessing, and  After Any 
Data Modification. Otherwise, if the users forget to upload the data to ECM before closing 
ChemStation, data might be lost.

NOTE Consider selecting the Cleanup Data on Shutdown check box when the system shall be 
compliant to 21 CFR Part 11. Using this function prevents unauthorized access to the local 
data files.
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• Locally Modified: Information whether the local copy has been modified

• Local Version: Version that was downloaded to the local directory

You can now manually select the data sets to be deleted from the local disk.

Alternatively, via a drop down list deselect all data sets, select all, select only 
single runs, select only sequence containers, select items older than today, or 
items older than a week.

After pressing OK, the local copies of the selected data sets are deleted.

Both automatic cleanup on shutdown and manual cleanup are only possible if 
the following conditions are fulfilled:

• the ChemStation user is logged on to ECM

• no other instance of the ChemStation instrument is open

• the spooler queue is empty

If one of these conditions is not fulfilled, automatic cleanup will not be 
performed and it is not possible to open the Data Cleanup dialog.

Spooler Queue Manager

The Spooler Queue Manager dialog is opened via  ECM > Manage Queue. If you 
selected the check box Manage Queue on Connect, and there are interrupted 
transfers, the dialog is also opened when you start ChemStation.

With this dialog, you can manage the data transfers from ChemStation to ECM 
that were interrupted or could not be started for any reason. Each failed 
transfer job is listed in a separate line.

Figure 7 Spooler Queue Manager
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The following information is provided for each line:

• Description: Information on the version of the data that will be transferred. 
Two values are possible:

• Import: No older version of the data exists in ECM at this time. The data 
has been newly created and will be uploaded as Version 1.

• Commit: There is already at least one version of the data in ECM. The 
version number of the uploaded data will be increased by one.

• Error: Error that disrupted the data transfer. For details on the possible 
errors, see “Error Messages in the Spooler Queue Manager” on page 146.

• Queued at: Date when the unsuccessful transfer was queued in the Spooler 
Queue Manager.

• Processed last at: Date when the transfer was last attempted.

The toolbar offers you the following commands to manage the queue:

When items are selected from the queue or saved to the local disk, an audit 
trail entry will be added to Audit Trail of ECM.

Table 2 Queue management toolbar

Icon Tooltip Description

Process queue Continue processing the transfer jobs. As long as there is no 
error, all pending transfer jobs will be processed in the order as 
they are shown in the list. This function is only active if you select 
the first line in the list. 

Stop processing Stop processing the transfer jobs.

Save selected item 
locally

Save the selected lines to a file. 
Only the displayed error, description, and dates are saved to the 
file. The respective data is not included!

Delete selected item Delete the selected transfer job from the queue. The concerned 
data will not be transferred to ECM. 

Properties Display the Queue Management dialog box, which shows details 
of the items in the queue in either summary or detailed form.

Refresh view Update the display of the items in the list.
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Queue Management Details Dialog Box

The Queue Management Details dialog box is displayed when you click the  
tool in the toolbar of the Queue Management dialog box. It shows the 
command-specific details of the commands in the  Queue Management dialog 
box. The Queue Management Details tabs offer two views of the command 
details:

• Summary tab

• Details tab

In either tab, the tools in the toolbar allow you to navigate through the 
command details: 

Summary tab

The Summary tab gives the following summary information about the selected 
item:

NOTE When items are deleted from the queue or saved to the local disk, they have not yet been 
uploaded to ECM.

Displays the details of the first command in the list.

Displays the details of previous command in the list.

Displays the details of next command in the list.

Displays the details of last command in the list.

Command Description The description of the item.

Created The date and time when the item was added to the queue.

Changed The date and time when the item was last processed.

Last Error A description of the error that caused the item to be added to the queue.
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Details tab

The Details tab gives detailed information about the selected item. You cannot 
edit the information in this list. The toolbar provides the following tools:

Sorts the properties by category.

Sorts the properties alphanumerically.

This tool is disabled under all circumstances in the ChemStation.
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Remote Data Path as Sequence Parameters

Instead of specifying the Remote Data Path in the Preferences for all acquisition 
sequences to be run (see “Remote Data Path” on page 45), the remote data 
path can also be set directly in the sequence template. This allows to set up 
different remote paths for each sequence without having to modify the 
Preferences. The Remote Data Path for a sequence template is set up in the  
Sequence Parameters tab.

Figure 8 Sequence Parameters tab of the Sequence Parameters dialog

Use Preferences: When this checkbox is enabled, the Remote Data Path as 
specified in the Preferences will be used. Any LCDF path specified in the 
Sequence Parameters will be ignored for this sequence. When this checkbox is 
disabled, the Remote Data Path will be used as specified when the sequence 
template is used for data acquisition. 
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Path: To specify the Remote Data Path, you need to select a Location and Cabinet 
available in the ECM Browser. Click Select Path to select the required path in 
an ECM Explorer dialog. For the Drawer and Folder, you can either keep the 
selected items, or you can select predefined tokens for an automatic path 
creation. When you use the predefined tokens in the  Remote Data Path, the 
system automatically creates the items if they do not already exist in ECM.

NOTE If you use tokens, make sure you have the required ECM privileges to create folders! 
Alternatively, another user who has the required privileges can create the necessary folders 
in advance. 
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Compressed ChemStation File Formats

When ChemStation data is uploaded to ECM, the data is automatically 
packaged into an SSIzip file. Depending on the type of data, different 
packaging formats are used. 

The packaging of ChemStation items is part of ChemStation OpenLAB Option 
and cannot be changed manually.

The packaging is automatically carried out when the data is uploaded to ECM. 
When the SSIZIP files are downloaded from ECM to ChemStation, they are 
automatically unpacked into the according directory in the ChemStation 
Explorer.

ChemStation data Packaging format Icon in 
ChemStation

Single Runs
(*.d file, ACQ.m and DA.M)

*.D.SSIZIP

Sequence Container
The sequence container contains recursively the whole 
sequence data stored in the sequence subdirectory:
• all *.d files along with ACQ.m and DA.M
• all methods *.m used during acquisition
• batch file *.b
• sequence logbook file *.log

*.SC.SSIZIP

Methods *.M.SSIZIP

Sequence templates *.S or
*.S.SSIZIP
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This chapter describes the basic workflows with ChemStation OpenLAB 
Option. There are four data-related workflows and two workflows for methods 
and sequence templates.
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Transferring Data to or from ECM

ChemStation OpenLAB Option provides the ability to open and save different 
ChemStation items into their ChemStation contexts:

• Methods

• Sequence templates

• Single run data 

• Sequence data

All of this data is stored in ECM as SSIZIP containers (see “Compressed 
ChemStation File Formats” on page 56).

When the data is uploaded to ECM, local copies of the files still remain in the 
ChemStation file system. If an item is loaded from ECM back into 
ChemStation, it is automatically loaded into its original location.

Different options are available regarding the automatic upload of single 
run/sequence data to ECM. Loading back stored data from ECM to 
ChemStation, however, always requires a manual load action. Methods and 
sequence templates require always a manual upload to ECM as well as a 
manual load or update into ChemStation.

For downloading data from ECM, several load commands are available in the  
ECM menu. Depending on the current view, you can load different files from 
ECM. In the Data Analysis view, you can load single run data or sequence data. 
These data are automatically set to the status checked out in ECM. In the  
Method and Run Control view, you can load methods and sequence templates. 
These items are only retrieved and not checked out. 

The following workflows are examples that represent typical tasks done with 
ChemStation OpenLAB Option.
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Data-related workflows

Workflow 1: Acquisition and automatic upload

Figure 9 Acquisition and automatic upload
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The workflow Acquisition and automatic upload, see Figure 9 on page 59, 
illustrates how raw data is uploaded to ECM directly after the acquisition is 
finished. The raw data is initially stored locally. After completing the 
acquisition, the data is automatically uploaded to ECM. 

To save data to ECM automatically after completion of a single run or 
sequence:

1 Log in to ECM in an online ChemStation.

2 Load a sequence template.

Your ECM user name is automatically inserted as operator name into the 
sequence template.

3 In the Data Analysis view, click View > Preferences.

4 On the Transfer Settings tab, configure the following settings:

• Remote Data Path: Select the ECM location that you want to use for the 
sequence data upload.

• Select the After Acquisition check box.

5 Configure the sequence parameters and the sequence table.

6 Start the acquisition.

While the acquisition is running, the raw data, method definition, and a 
copy of the sequence template are locally stored on the ChemStation 
computer.

After the sequence is finished, all data is automatically uploaded as an 
.SC.SSIZIP file to ECM to the previously defined LCDF path. The local copy 
of the data remains on the ChemStation computer. The file name of the 
sequence container is determined by the settings in the sequence template 
(for more details on the sequence template settings, refer to the manual 
Understanding Your ChemStation). After uploading the sequence 
container the sequence icon in the ChemStation Navigation Pane changes 

from  to  . The LCDF path of the sequence container is shown in the 
ChemStation toolbar.
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NOTE The color of the Sequence Data icon in the Navigation Pane allows to track the 
modification status of the data:

: The sequence container is stored in ECM and has not been modified locally

: The sequence container is stored in ECM and has been modified locally

NOTE The upload process may take some time when large amounts of data are uploaded. During 
this time ChemStation is busy and the user cannot perform tasks in ChemStation. Please 
wait until the upload is completed.
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Workflow 2: Offline review during acquisition

Figure 10 Offline review during acquisition

The workflow Offline revision during acquisition, see Figure 10 on page 62, 
illustrates how raw data is reviewed while the acquisition is still running. 
Directly after the acquisition is finished, the original raw data is automatically 
uploaded to ECM. After the review, the changed data is again uploaded to 
ECM. When the data is uploaded the second time, a new version is created.
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To save data to ECM automatically after changing the data:

1 Log in to ECM in an online ChemStation.

2 Load a sequence template. 

Your ECM user name is automatically inserted as operator name into the 
sequence template.

3 In the Data Analysis view, click View > Preferences.

4 On the Transfer Settings tab, configure the following settings:

• Remote Data Path: Select the ECM location that you want to use for the 
sequence data upload.

• Select the After Acquisition check box.

• Select the After Any Data Modification check box.

5 Start the acquisition.

While the acquisition is running, the raw data, method definition, and a 
copy of the sequence template are stored locally on the ChemStation 
computer.

6 Open an offline ChemStation and change some data analysis parameters for 
one of the already finished samples. Save your changes locally.

7 After the acquisition has been finished, two things will happen:

• The original raw data is automatically uploaded as an .SC.SSIZIP file, 
Version 1, to ECM to the previously defined LCDF location. The LCDF of 
the new sequence is shown in the toolbar in the online ChemStation.

The file name of the sequence container is determined by the settings in 
the sequence template (for more details on the sequence template 
settings refer to the manual Understanding Your ChemStation). 

The sequence icon in the ChemStation Navigation Pane changes from  

to  .

• The ECM forced upload dialog opens in the online ChemStation. Click  OK 
to confirm that you finished all work in the offline instance. As soon as 
you confirm this dialog, the changed data is uploaded as Version 2 to 
ECM.

A local copy of the changed data remains on the ChemStation computer.
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Workflow 3: Reprocessing data and automatic upload

Figure 11 Reprocessing data and automatic upload

NOTE For both versions (the one after acquisition and the one from the parallel offline review) the 
ECM operator is the user who has run the acquisition, even if another user has performed 
the review in the Offline ChemStation.
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The workflow Reprocessing data and automatic upload, see Figure 11 on 
page 64, illustrates how data is reprocessed and then automatically uploaded. 
This workflow applies to data that has been previously stored in ECM. A new 
version of the data is created in ECM for the reprocessed or changed data.

To save data to ECM automatically after reprocessing:

1 Log in to ECM in ChemStation (online or offline).

2 Select ECM > Load Data to download a sequence from ECM.

The ECM Desktop Open dialog opens. Navigate to the ECM folder to load the 
data of your choice and select one of the following packaged files:

• Single run data: *.D.SSIZIP files

• sequence data: *.SC.SSIZIP files

Figure 12 ECM Desktop Open dialog

If the item is checked out, it is marked with a blue or red icon (see 
marker 1):

 (blue icon): the item has been checked out by you (current user)

 (red icon): the item has been checked out by another ECM user

You can load any checked out item. However, if an item has been checked 
out by another ECM user, the other user must check in the item before you 
can save it back to ECM.
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To check out or check in an item, you can use the respective icons available 
in the ECM Desktop Open dialog (see marker 2). You can only check out the 
latest version of an item.

In order to see more details regarding the type and version of the available 
items, select the Detail view (see Figure 12 on page 65, marker 3). To open 
an older version of an item, select the Open Revisions command from the 
Open menu (see Figure 13 on page 66). This opens the  File Versions  dialog, 
where all available versions of the item are listed (see Figure 14 on 
page 67).

Figure 13 Open Revisions command
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Figure 14 File versions dialog

3 Select Open in either dialog to download the item to ChemStation. 

If the item was not already checked out, it is automatically checked out of 
ECM when you load it to ChemStation.

The LCDF path of the data is shown in the ChemStation toolbar.

4 In the Data Analysis view, click View > Preferences.

5 On the Transfer Settings tab, configure the following settings:

• Select the After Reprocessing check box.

• Select the After Any Data Modification check box.

6 Modify or reprocess the sequence data.

After the reprocessing is finished, the sequence data is uploaded with its 
original name to its original LCDF path. The version number is increased by 
one.

The local copy of the reprocessed data remains on the local file system of 
the ChemStation computer.
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Workflow 4: Import after reprocessing

Figure 15 Import after reprocessing

The workflow Import after reprocessing, see Figure 15 on page 68, illustrates 
how locally saved data is reprocessed and then automatically imported in 
ECM.

To save data to ECM automatically after reprocessing:

1 Log in to ECM in an offline ChemStation.
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2 From the local file system, open a sequence that has never been saved to 
ECM before.

3 In the Data Analysis view, click View > Preferences.

4 On the Transfer Settings tab, configure the following settings:

• Remote Data Path: Select the ECM location that you want to use for the 
sequence data upload.

• Select the Import after Reprocessing check box.

5 Reprocess the sequence data.

The sequence data is uploaded as a new .SC.SSIZIP file, version 1, to the 
previously defined LCDF path in ECM. The file name of the sequence 
container is determined by the settings in the sequence template (for more 
details about the sequence template settings refer to the manual 
Understanding Your ChemStation).

The sequence icon in the ChemStation Navigation Pane changes from  to  

.

The local copy of the reprocessed data remains on the local file system of the 
ChemStation computer.

NOTE The data will not be uploaded if you only modify it. You need to reprocess the sequence 
data.
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Workflows for Methods and Sequence Templates

Workflow 1: Local files – Save new method

Figure 16 Local files - Save new method
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The workflow Local files - Save new method, see Figure 16 on page 70, 
illustrates how newly created or locally stored methods or sequence template 
can be manually uploaded to ECM.

To upload a new method or sequence template:

1 Log in to ECM in an offline ChemStation.

2 In ChemStation, load the method/sequence template or create a new one.

3 In the Method and Run Control view, click ECM > Save Method or 
ECM > Save Sequence Template, respectively.

The ECM Save dialog opens.

4 Navigate to the Remote Data Path of your choice to upload the 
method/sequence template.

You can only upload items into a Folder, not into a Location, Cabinet, or 
Drawer.

5 If necessary, save the item using a different name. the original name is used 
by default, but you can modify the name.

6 Click Save.

The Add File dialog opens. 

7 Enter a reason for the upload and click OK. The reason is then shown in the 
ECM Audit Trail (see “ECM Audit Trail” on page 86).

The progress of the upload is displayed in a window until the item is 
uploaded to ECM. 

After finishing the upload, the SSIZIP file is available in ECM as version 1. 
The file is saved to the Remote Data Path defined in the Preferences (see 
“Remote Data Path” on page 45). 

The method icon in the ChemStation Navigation Pane changes from  to  

. The icon for a sequence template changes from  to   accordingly.
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Workflow 2: ECM – Save changed method

Figure 17 ECM - Save changed method

The workflow ECM - Save changed method, see Figure 17 on page 72, 
illustrates how methods or sequence templates that are already stored in ECM 
are edited and saved under the same name as a new version.

1 Log in to ECM in ChemStation.

2 Load a method or sequence template.
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• Open a method/sequence template from your local PC. Choose a 
method/sequence template that has been uploaded to ECM before. ECM 

Methods are indicated by , ECM sequence templates by   in the 
ChemStation Navigation Pane.

– or –

• Select ECM > Load Method or ECM > Load Sequence Template respectively to 
download a method/sequence template from ECM.

If you use one of the Load commands, the ECM Desktop Open dialog will open. 
Navigate to the ECM folder to load the method (*.M.SSIZIP) or sequence 
template (*.S or *.S.SSIZIP) of your choice.

Figure 18 ECM Desktop Open dialog

If the item is checked out, it is marked with a blue or red icon (see Figure 18 
on page 73, marker 1):

 (blue icon): the item has been checked out by you (current user)

 (red icon): the item has been checked out by another ECM user

You can load any checked out item. However, if an item has been checked 
out by another ECM user, the other user must check in the item before you 
can save it back to ECM.
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To check out or check in an item, you can use the according icons available 
in the ECM Desktop Open dialog (see Figure 18 on page 73, marker 2).With 
these icons, you can only check out the latest version of an item.

In order to see more details regarding the type and version of the available 
items, select the Detail view (see Figure 18 on page 73, marker 3). To open 
an older version of an item, select the  Open Revisions command from the 
Open menu (see Figure 19 on page 74, marker 1). This opens the File Versions  
dialog, where all available versions of the item are listed (see Figure 20 on 
page 75).

Figure 19 Open Revisions command
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Figure 20 File versions dialog

3 Select Open in either dialog to download the item to ChemStation. In order 
to prevent other users from modifying the item, it is possible to select the 
Open As Checked Out command to mark the item as checked out from ECM 
(see Figure 19 on page 74, marker 2).

If the file already exists on the ChemStation computer in the specified 
location, you must choose a different download location.

The LCDF path of the loaded method/sequence template is shown in the 
ChemStation toolbar in ChemStation.

4 Make some changes to the method/sequence template.

The modified method is indicated by 

, a modified sequence templates by  in the Navigation Pane.

5 Select ECM > Save Method or ECM > Save Sequence Template respectively to 
save the changed method/sequence template.

NOTE Unlike the data files, the methods and sequence templates are not automatically checked 
out of ECM! In order to modify those items in ChemStation, you should check them out from 
ECM manually. Otherwise, there is no guarantee that you are working on the latest version.

NOTE If you have not checked out the item before loading it from ECM, and another ECM user has 
checked out the item in the meantime, you cannot proceed with the upload back to ECM. A 
warning message is displayed, and it is not possible to save the item back to ECM until the 
other user has released the checked out item.
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6 When the Add File dialog opens, enter a reason for the upload and click OK. 
The reason is then shown in the ECM Audit Trail (see “ECM Audit Trail” on 
page 86).

The progress of the upload is displayed in a window until the item is 
uploaded to ECM. 

The .M.SSIZIP/.S file is uploaded with its original name to its original LCDF 
path (the path is shown as a tooltip of the method/sequence template in 
ChemStation). The version number is automatically increased by one.

Updating the Local Master Method or Sequence Template

If a master method or sequence template is updated in ECM (i.e. a new version 
is created), it is possible to update the local copies with the following update 
procedure.

1 Make sure the master method or sequence template to be updated is 
currently not loaded. The currently loaded method or sequence template is 
not available for update.

2 Select ECM > Update Methods ... or Update Sequence Templates ...

Figure 21 Update Methods dialog box

The Update from ECM dialog box is displayed.

The dialog box lists all methods that are connected to ECM. The following 
columns are available:
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• Name: Path and Name of the local copy of the method/sequence template.

• ECM Information: ECM server, account information, and LCDF path of the 
file in ECM.

• Locally Modified: A check box indicating whether the local copy was 
modified.

• Local Version: Version number of the local copy of the method/sequence 
template.

• ECM Version: Version number of the file in ECM.

3 You can now manually select the methods that are to be updated. 
Alternatively you can via the drop down list deselect all methods, select all 
methods, select to those methods with a higher version number in ECM, or 
select all methods that have been modified locally. 

After pressing OK, the selected local methods/sequence templates are 
updated with the version in ECM.
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Introduction to 21 CFR Part 11

Effective August 20, 1997, the U.S. Food and Drug Administration (FDA) 
released and published a new rule to enable pharmaceutical companies to 
approve their results with electronic signatures and to transfer paper-trail 
documentation into electronic records. This rule is known as 21 Code of 
Federal Regulations Part 11 (referred to as 21 CFR Part 11) and applies to all 
industry segments regulated by the FDA.

The impact of this rule on current work practices and data handling in the 
pharmaceutical industry has been much higher than expected. “The industry 
wanted to have a rule on electronic signatures, but what they got was a rule 
on electronic records.” (Martin Browning, former FDA inspector, during a 
validation seminar in Washington D.C.)

21 CFR Part 11 places high emphasis on the implementation of all measures to 
protect and secure electronic records. Notwithstanding the uncertainties and 
the changes that 21 CFR Part 11 requires in the behavior of both the 
pharmaceutical industry and the vendors of chemical analysis equipment, it is 
well worth implementing in today’s laboratories because it can help the 
industry with one of the most important issues in pharmaceutical 
research-bringing new drugs on the market faster.

The major benefits of this shift towards electronic data management are in the 
potential productivity increase for the industry. The industry can decrease its 
data output on paper, speed up the data review and approval process, and 
benefit from new automation technology based on computerized system 
control, for example, in manufacturing or dissolution drug release testing.

In addition to this rule on electronic records, other general requirements for 
computerized systems are brought to the auditor’s attention. These rules cover 
the basic requirements of validation which are limiting data access and 
ensuring data integrity and data traceability. 

It is, of course, the industry that must ensure that its work practices support 
the FDA rules, but most of the requirements also affect the chemical analysis 
systems and suppliers of these systems.
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21 CFR Part 11 Requirements

To fulfill the FDA rules and guidelines for compliant electronic records and 
computerized systems, it is important to understand the basic aspects of 
secure data handling.

• Data security: physical protection of data by limiting access to the system 
and preventing unauthorized access.

• Data integrity: protecting raw data and metadata and preventing these 
from unauthorized modification, and linking raw data and results to 
reproduce the original results at any time, for example, in an audit 
situation, and document each new result copy.

• Audit traceability: documenting who did what to the results and when, and 
tracing the user adding new reanalyzed versions to the original raw data.

General Aspects of Data Security in Computerized Networks – 
Open Versus Closed Systems

Before discussing details of data security in a chromatographic system, some 
general aspects of data security in a computerized network need to be 
considered.

It is generally known that data transfer over a public network can be accessed 
by unauthorized external persons, “hackers”, who gain access either for 
personal amusement or intentional fraud. 

If an electronic identification comprising user ID and a password is used to 
approve confidential or important data, users must be sure that their 
signatures are unbreakably linked to the data and that nobody can copy this 
signature or get access to the passwords. In a public system, this would 
require additional encryption technology, for example, a private/public key 
combination of data encryption. In contrast, if a computerized system is 
protected from unauthorized access, users can be sure that their signatures 
are private and are not accessible to unauthorized individuals.

The FDA also distinguishes between these two scenarios and defines them as 
open and closed systems. A public network system can therefore only be 
viewed as an open system and a protected network as a closed system, if it 
fulfills additional requirements.
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In FDA terms, “closed system means an environment in which access is 
controlled by persons who are responsible for the content of electronic 
records on the system” (11.3.5). The evidence of a system being a closed 
system is not a one-time check but an ongoing process of executing and 
documenting the system controls that make sure that the system is closed. In 
contrast, in an open system, “those persons being responsible for the content 
of electronic records do not control the system access.”

As a result, open systems require additional encryption technology for all data 
transfer over the network.

ChemStation OpenLAB Option is designed for and supported in closed 
systems.
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Overview of Configuration Steps Required for Part 11

If you want to configure ChemStation OpenLAB Option to be compliant with 
21 CFR Part 11, you need to go through the following checklist:

• LCDF structure on the ECM Server prepared according to your needs

See “Data Storage in ECM” on page 16.

• ChemStation OpenLAB Option installed on the ECM Server

See “Updating the ECM Database” on page 22.

• ECM Roles/Users/Groups configured

See “Configuring users, roles and privileges” on page 25.

• ECM Account configuration with active audit trail and mandatory reason

See “To enable the ECM Audit Trail” on page 87 and “Account 
configuration” on page 89.

• Password policy realized in ECM (including E-mail Notification)

See “To configure the password settings for an ECM Account according to 
the password policy” on page 90.

• E-Signatures prepared (messages and privileges)

See “Using electronic signatures” on page 96.

• ChemStation with ChemStation OpenLAB Option and mandatory ECM 
login

See “Installing a new ChemStation with ChemStation OpenLAB Option” on 
page 28.

• Automatic Data Transfer Settings and Transfer Management Settings 
activated

See “ECM Preferences” on page 44.

• Audit trail active for methods and results

See “Method Audit Trail” on page 84 and  “Results Audit Trail” on page 85.

• Emergency Plan available, based on options of the Administration Tool

See “ChemStation Administration Tool” on page 92.
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Audit Trails and Logbooks

In order to comply to 21 CRF Part 11, ChemStation OpenLAB Option offers 
various audit trails and logbooks to document all activities associated with 
methods, results, reports, or with ECM files generally. These audit trails and 
logbooks track all changes that are made to any file, including data 
acquisition, re-analysis, and long-term archiving.

The audit trails are stored in separate files, which are stored together with the 
sample or method data. The audit trail files are archived together with the 
other data in the according SSIZIP files. The ECM logbooks are available only 
directly in ECM.

Method Audit Trail

Each method has a Method Audit Trail. By default, this Method Audit Trail 
contains only the comments that you must provide each time when you save a 
method. As there is no control on the provided text, there is no guarantee that 
the method changes are reproducible.

With regards to 21 CFR Part 11, ChemStation OpenLAB Option makes it 
possible to generate a more detailed Method Audit Trail. If the function is 
activated, the Method Audit Trail contains not only the user comments, but 
also each individual changed parameter with its old and new value. All 
changeable data analysis parameters are tracked. This means that you can 
reproduce exactly which value has been changed to what, when, and by whom.

To enable the Method Audit Trail for all methods

This is required if you want to comply to 21 CFR Part 11.

1 Select View > Preferences

2 In the Audit Trail Status dialog, select Enable Audit Trail for this method and click 
OK.
Once enabled, the Method Audit Trail cannot be disabled.

NOTE You can also use the ChemStation Administration Tool to enable the Method Audit Trail for 
all methods (see “ChemStation Administration Tool” on page 92).
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To enable the Method Audit Trail only for the currently open method

You can also activate the Method Audit Trail only for one method. This might 
be useful, for example, when you finished the development of new method and 
want to track all further changes.

1 Select Method > Enable Audit Trail

2 On the Audit Trail tab, select Enable Method Audit Trail for all methods.

To view the Method Audit Trail for the currently open method in 
ChemStation

1 Select Method > Method Audit Trail.

To remove the detailed Method Audit Trail

Once a method is enabled for the detailed audit trail, you cannot disable it 
again. The only way to get rid of an existing Method Audit Trail is to save the 
method under a different method name. In this case, the only hint in the new 
method’s audit trail is a comment about the method being based on another 
method.

Results Audit Trail

Manual integration events are not saved in the method. Therefore, the Method 
Audit Trail contains no information on manual integration events. These 
events are only saved in the data file. Nevertheless, they have an influence on 
the results. Manual integration events are therefore saved as part of the 
Results Audit Trail.

If activated, this Results Audit Trail is added to the existing Data File Logbook 
(file name RUN.LOG). By default, the Data File Logbook only contains the 
acquisition parameters and reprocessing information for each sample. The 
Results Audit Trail additionally tracks the changes of all data analysis 
parameters for a sample. 
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To enable the Results Audit Trail

If you enable the Results Audit Trail, the relevant changes are tracked for all 
samples, independent of the sequence they belong to and independent of the 
user who carries out the change.

1 Select View > Preferences

2 On the Audit Trail tab, select Enable Results Audit Trail.

To view the Results Audit Trail for the loaded sample in ChemStation

1 In the Data Analysis view, select View > Current Data File Logbook.

Report History

If you create a ChemStation report, you can display the report on the screen, 
send it to a printer, or save the report as a specific file (report.pdf). These 
report outputs may easily be lost or overwritten, especially when you create 
several reports after each other.

With ChemStation OpenLAB Option, ChemStation automatically tracks any 
report that was generated. In order to reproduce an old or overwritten report, 
select Report > Report History. Here, you can see all reports created for the 
current data file since the installation of ChemStation OpenLAB Option. You 
can also export or print this history.

ECM Audit Trail

Audit Trail is a record showing who accessed the system and what operations 
he or she performed during a given period of time.

You can view file-related, system administration, folder administration, and 
scheduler-related entries. For example, you can see when a file was added and 
who added it.

For each operation, ECM asks the user for a reason. This reason is also shown 
in the ECM Audit Trail. For automatic uploads there are default reasons given 
by the system. The reason entry may be optional or mandatory, depending on 
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the ECM configuration (see “Account configuration” on page 89). If the system 
is configured to be compliant to 21 CFR Part 11, providing a reason is 
mandatory.

To enable the ECM Audit Trail

You can enable the ECM Audit Trail only for a complete ECM Account. To 
activate the ECM Audit Trail, you must select the check box Enable audit trail for 
this account when creating a new account.

There is no possibility to activate the ECM Audit Trail afterwards for an 
existing account, or to deactivate the ECM Audit Trail again.

To view the ECM Audit Trail for a specific file

1 In ECM, right-click the respective file and select Properties from the context 
menu.

2 In the File Properties dialog, select the  Audit Trail tab.

All actions related to this specific file are listed here, together with the 
date, ECM user name who performed the action, and a reason provided by 
the according user.

To view the ECM Audit Trail for all files

1 In ECM, select the Administration page.

2 In the Navigation Pane, select the Activity Log > Audit Trail node.

All actions related to any ECM file are listed here, together with the file 
name, date, ECM user name who performed the action, and a reason 
provided by the according user. 

You can search the entries, for example, for a specific date or date range, or 
for entries related to specific categories (Files, Folders, System, Scheduler, 
or Instrument). Also you can print the entries or export them to a file.

NOTE If the system shall be compliant to 21 CFR Part 11, the ECM Audit Trail must be enabled.
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ECM System Log

The System Log is a record that shows changes to the system, including 
configuration changes, e-mail notifications, and additions or changes of 
Locations, Cabinets, Drawers, or Folders.

You can view file-related, system administration, folder administration, or 
Scheduler-related entries. For example, you can see when a Location was 
added and by whom.

The System Log is always active; you do not need to enable it.

To view the ECM System Log

1 In ECM, select the Administration page.

2 In the navigation pane, select the Activity Log > System Log node.

All general actions related to ECM are listed here, together with the date, 
ECM user name who performed the action, and a reason provided by the 
respective user. Depending on the ECM Account administration, the reason 
may be optional or mandatory (see “Account configuration” on page 89).

You can search the entries, for example, for a specific date or date range, or 
for entries related to specific categories (Files, Folders, System, Scheduler, 
or Instrument). Also you can print the entries or export them to a file.
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Administration in ECM

When you install ChemStation OpenLAB Option, you need to carry out certain 
basic configuration tasks in ECM (see “Installation and Configuration Tasks 
on ECM Server” on page 22). In addition, there are several other settings in 
ECM that are relevant with regard to 21 CFR Part 11. These settings are 
described in the following section.

Account configuration

To configure the ECM Account

1 In ECM, select the Administration page.

2 In the Navigation Pane, select the Account Administration node.

3 Double-click the Configuration item. 

The Account Administration dialog opens.
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Users/Groups/Roles

To configure the password settings for an ECM Account according to the 
password policy

1 In ECM, select the Administration page.

2 In the navigation pane, select the Account Administration node.

3 Double-click the Users/Groups/Roles item. 

Setting Description 21 CFR Part 11 Requirements

Lockout If a user tries too often to log in with 
invalid user credentials, he is locked out 
of the system and cannot log in any more 
– not even with valid user credentials. 
You can define the number of allowed 
login attempts.

You should limit the number of 
allowed login attempts to 
three.

Inactivity Timeout If a user does not perform any action in 
ChemStation for the given period of time, 
he is automatically logged out. The same 
applies to the ECM Web Client.

You should specify a timeout.

System administrator 
email

The e-mail address you provide here will 
automatically be notified when a user 
was locked out after too many 
unsuccessful login attempts.

You should provide an e-mail 
address.

Minimum Password 
Length

If users change their passwords, they 
must choose a password with at least the 
given number of characters. The default 
setting is 5.

You should require a minimum 
password length of at least 5 
characters.

Require entry in 
Reason fields

In each ECM Audit Trail or System Log 
entry the users can enter a specific 
reason for the action. If this check box is 
selected, the entry is mandatory.

The ECM Audit Trail and 
System Log reasons must be 
mandatory.

NOTE 21 CFR Part 11 requires that company/the laboratory has a password policy.
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The Account Administration dialog opens.

21 CFR Part 11 does not define any specific rules for the password settings. 
However, your company must have defined a password policy. You may 
consider the following settings:

• User cannot change password

• User must change password after next login

Note that the minimum password length is defined in the ECM Account 
configuration (see “Account configuration” on page 89).

Roles and folders

ECM allows you to assign specific roles to users or user groups. This can be 
done at the global level for the entire ECM Account, or individually for specific 
folders. For example, a specific user group may have the Contributor role for 
folder A, but at the same time have only the Reader role for folder B.

To enable roles for folders:

1 In ECM, select the Administration page.

2 In the navigation pane, select the Account Administration node.

3 Double-click the Users/Groups/Roles item. 

The Account Administration dialog opens.

4 On the Roles tab, select the required role and click Edit.

5 Select the Available in folder access tab check box.

Preparations If you want to assign roles at the folder level, you must first enable this feature in ECM. The setting is 
valid for the complete ECM Account.
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Administration of ChemStation Settings

ChemStation Administration Tool

The ChemStation Administration Tool offers a number of functions which are 
helpful if the ECM Server is down and the connection from the ChemStation 
client to the ECM Server is lost. As one of these functions is to switch off the 
mandatory ECM login, the access to the ChemStation Administration Tool is 
strictly limited. The ChemStation Administration Tool can only be started by 
users who are a member of the local user group CSAdministrators (see “Enabling 
users to start the ChemStation Administration Tool” on page 33).

To start the ChemStation Administration Tool:

1 From the Start menu in the Task Bar, select Start > All Programs > Agilent 
ChemStation > ChemStation Administration Tool.

Figure 22 ChemStation Administration Tool
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Login options

The following check boxes are relevant in case of an emergency, that is, if the 
ECM Server is down:

• Mandatory Login: If you clear this check box, all ChemStation instances on 
this client can be started without an ECM login. If the ECM login used to be 
mandatory and the ECM Server is down, clearing this check box can be 
used to make ChemStation accessible again.

• Start ChemStation when ECM is unavailable: If you select this check box, the 
ChemStation can be started when the ECM server is unavailable even if 
Mandatory Login is enabled. The Login dialog at startup of ChemStation can 
be cancelled. With this option selected, any user can continue to work in 
ChemStation in case the server is down without contacting a user who has 
access to the Administration Tool.

• Break Session Lock: If you select this check box, a locked ChemStation can be 
accessed by any user just by clicking Cancel in the  Login dialog. If a 
ChemStation is currently locked and the ECM Server is down, selecting this 
check box is the only possibility to regain access to the current 
ChemStation session.

The following check boxes allow you to configure the timebased session lock 
and the ChemStation toolbar Lock Button:

• Timebased session lock locks private: If you select this check box, the time 
based session lock will lock the ChemStation sessions privately. Otherwise, 
the timebased session lock will be non private.

NOTE Be aware that, as a consequence, the privileges of the ChemStation users are now 
unlimited. The users have access to all ChemStation functions.

NOTE Be aware that, as a consequence, the privileges of the ChemStation users are now 
unlimited. The users have access to all ChemStation functions.

NOTE Be aware that, as a consequence, the user who regained access to ChemStation now has 
unlimited access to all ChemStation functions.
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• Toolbar Lock Button locks private: If you select this check box, the ChemStation 
toolbar lock button will lock the ChemStation session privately. Otherwise, 
a non-private lock will be applied.

Data Handling and Audit Trail Configuration

The ChemStation Administration Tool offers to conveniently configure all 
ChemStation instances on a client at the same time with the same settings. By 
default, the option Use instance specific settings is selected, so that the settings 
are not overwritten.

To change the settings for all ChemStation instances

1 Select the option Use these settings for all instances on this computer.

2 Select the required check boxes. The settings are the same as in the 
Preferences dialog (see “ECM Preferences” on page 44).

3 Click OK.
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Electronic Signature

Electronic signatures provide a means to sign documents as equally binding as 
a handwritten signature. In addition, electronic signatures are reproducible, 
because they are recorded in a secure, time stamped audit trail. Manipulation 
is prevented by enabling only users with specific privileges to sign 
electronically.

An electronic signature contains the user name (full name), date, and time 
when the signature was applied, the location where the signing occurred, and 
a user-configurable definition associated with the signature. The signature is 
always related to the complete SSIZIP container, not to a single file inside the 
container.

CFR 21 Part 11 requires that companies, especially ones that employ any type 
of approval process, use electronic signatures. With the help of the Agilent 
OpenLAB Business Process Manager (BPM) module, you can create highly 
automated review or approval processes including e-mail notification.

Preparation

Privileges

An ECM user needs to have the privilege Content: File Signatures in order to be 
able to sign electronically. This privilege is, for example, assigned to the ECM 
default role: :Approver.

Reasons for the signature

With each signature the ECM users must either select a given reason or, if they 
are allowed to, provide their own reason. 

To configure the reasons for signatures:

1 In ECM, select the Administration page.

2 In the navigation pane, select the Account Administration node.

3 Double-click the Electronic Signature item.
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The Account Administration dialog opens.

4 To provide a new reason, enter the required text into the Reasons field and 

click .

5 To delete an existing reason, select the reason in the Default reasons list and 

click .

6 If you want to allow users to provide their own reason with a signature, 
select the User can specify reason check box. 

7 If necessary, adjust the timeout settings:

• The Signature screen timeout defines, how long an e-signature dialog will 
stay open if no signature is submitted. The default setting is 5 minutes.

• The Consecutive signature timeout is relevant if an ECM user carries out 
several successive e-signatures. If the next e-signature takes place within 
the given timeout interval, the location and the  reason provided in the 
first e-signature will be pre-filled in the next dialog. The default setting 
for the consecutive signature timeout is 5 minutes.

Using electronic signatures

To apply an electronic signature

1 Right-click the required SSIZIP container and select Electronically Sign > 
Electronic Signature from the context menu.

The Electronic Signature dialog opens.

2 Enter your ECM user credentials (username, password, and domain).

NOTE If you clear this check box, the users can only select one of the given default reasons.

NOTE The other command in the context menu, Electronically Sign > Acrobat Plug-In 
Signature, works only for PDF documents and only if you purchased the according plugin. It 
enables you to add signatures directly inside PDF documents.
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3 Enter your current location. With this information, the location from where 
you provide the signature is reproducible.

4 Select a reason for the signature from the Default reason drop-down list.

- Or -

Select the User specified check box and enter a different reason into the text 
field. Note that this option is only available if the ECM Account is 
configured accordingly.

5 Click Sign.

The file is now signed electronically. The e-signature is shown in the file 
properties in the eSig tab. The e-signature is also included in the ECM Audit 
Trail.

To view electronic signatures

The user preferences in ECM can be configured in such a way that the number 
of e-signatures applied to a file is shown by default in the ECM content display, 
together with the file name and status.

The electronic signature itself is shown in the file properties in the eSig tab, 
and it is also part of the ECM Audit Trail.

To adjust the user preferences: 

1 In ECM, select the Administration page.

2 In the navigation pane, select the Account Administration node.

3 Double-click the User Preferences item.

4 Click Modify... to modify the column settings.

5 Select # of signatures and click  to add this property to the selected 
columns.

6 Click OK.

The number of e-signatures is then shown on every content page in ECM.
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This chapter explains the purpose and usage of custom fields in ChemStation.
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About Custom Fields

ChemStation provides numerous fields in which you can enter information on 
a sequence, specific samples, or the expected compounds. These fields are 
sufficient for many standard analysis tasks. However, for some specific tasks 
you may need to save additional information on the samples or compounds. In 
this case, you can define the so-called custom fields.

Custom fields are available for sample information and for compound 
information. The custom fields definition is saved as part of the method 
definition. When you define custom fields, you can define a suitable field 
name and data type for the additional information, according to your needs.

After you have defined the custom fields, you can enter the actual values in 
the sequence table of the current sequence. These values will be shown on 
ChemStation reports and are available also for OpenLAB Intelligence reports. 
In OpenLAB Intelligence reports, the values can even be used for calculations 
or statistical evaluations.

In addition, you can use custom fields to flag all samples related to a specific 
project or study. This flag is then used by OpenLAB Intelligence Reporter to 
find all results related to this specific project or study.
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Setting Up Custom Fields

The custom fields definition is part of the method. You can define up to ten 
custom fields related to the samples, and up to ten custom fields related to the 
compounds. Also, you can import the custom fields definitions from another, 
existing method.

To define new custom fields

1 Select the Method and Run Control view.

2 Load the required method.

3 Select Method > Custom Fields Setup.

The Set up Custom Fields definitions dialog opens. It contains two sections, one 
for sample custom fields, and one for compound custom fields.

Figure 23 Set up Custom Fields definitions dialog
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4 Click  to add a new custom field in the according section.

5 Enter a suitable name for the new custom field (for example, Color).

6 Select a suitable data type (for example, TEXT).

7 If appropriate, enter a default value (for example, Blue).

8 If appropriate, select the Mandatory check box to ensure that the custom 
field is always filled. 

If you make a custom field mandatory, you should also provide a default 
value.

9 If required, click  to delete a selected custom field.

10 If required, adjust the order of the custom fields with the Up  and Down 

 buttons.

To import custom fields from an existing method

1 Make sure the method with the custom fields is available in your local file 
system.

2 Load the target method (the one to which you want to import the custom 
fields definition).

3 Select Method > Custom Fields Setup.

4 Click Import. A dialog opens where you can select the source method from 
the local file system.

5 Click OK.

NOTE If you create sample custom fields named Project or Study, these custom fields will be 
reported twice in the .acaml file: in the regular custom fields section, and also in the 
projects/study mapping. This enables OpenLAB Intelligence Reporter to find all results 
related to a specific project or study.
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Specifying Custom Fields Values

The specific values of the predefined custom fields depend on the actual 
sequence. Therefore, the values are specified in the sequence table. 

To provide sample custom fields values

1 In the Method and Run Control view, load the required sequence.

2 Select Sequence > Sequence Table to open the sequence table.

3 Click Custom Fields.

The Set up Custom Fields values dialog opens. The Sample Custom Fields tab is 
active. Each predefined custom field is shown in a separate column. 
Mandatory custom fields are marked with (*) in front of the field name.

The lines correspond to the lines in the sequence table.

Figure 24 Set up Custom Fields values - Sample Custom Fields

4 Enter the required values for each sample and custom field. 

NOTE You can only start a sequence after the mandatory fields have been completed.
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To provide compound custom fields values:

1 Select the Compound Custom Fields tab.

Figure 25 Set up Custom Fields values - Compound Custom Fields

2 Select the required compound from the drop-down list at the top, or click 

, , , or  to navigate to the required compound.

3 Enter the required values for each sample and custom field.

4 Select the other compounds and provide the values accordingly.

5 Click OK.

NOTE This tab is only available if compounds have been set up in the method's calibration table.
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Reporting of Custom Fields

Custom fields values are always saved to ECM and are therefore always 
available in OpenLAB Intelligence Reporter. However, they are not 
automatically shown in ChemStation reports. If you want to display the 
custom fields in your ChemStation reports, you must first adjust the report 
options.

To display custom fields in ChemStation reports

1 Select the Data Analysis view.

2 Select Report > Specify Report.

3 Select the check boxes Add Sample Custom fields to Sample info and Add 
Compound Custom fields.

4 Click OK.

The custom fields and the according values are then displayed on 
ChemStation reports (see examples below).

Figure 26 Sample custom fields
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Figure 27 Compound custom fields
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Reprocessing with Custom Fields

It is possible to modify the values of the custom fields during reprocessing. 
When you prepare the reprocessing, you can edit the custom fields values in 
the Sequence Table in the Data Analysis view. For more information on 
editing custom fields values, see “Specifying Custom Fields Values” on 
page 103.

After an acquisition, you can only edit the values of existing custom fields, 
that is, custom fields that were defined in the method used for the acquisition. 
You can not add new custom fields afterwards, even if the method used for 
reprocessing contains different custom fields than the original method.
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This chapter provides information on migrating legacy ChemStation sequence 
data to sequence container format, in order to be able to upload these data sets 
to ECM.
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Introduction

When ChemStation OpenLAB Option is installed, Unique Folder Creation can not 
be switched off. All sequence data sets that are acquired are therefore stored 
as sequence container. Please refer to the manual “Getting Started with New 
ChemStation Workflow” for more details on working with Unique Folder 
Creation.

The sequence container format of sequences is essential for upload to ECM. 
Therefore ChemStation legacy sequence data acquired with ChemStation 
prior to B.02.01 or while Unique Folder Creation was off, have to be migrated to 
sequence container format before they can be uploaded to ECM.

Legacy ChemStore data that have been migrated to ECM can also be converted 
to be reviewed in the Navigation Table.
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Sequence Container Migration

ChemStation provides a tool to migrate non-container data to sequence 
container format. To successfully perform this task, it is required that the 
original sequence file is still available. It must contain all the necessary 
sequence lines and follow the original data file naming scheme to reprocess all 
the data files of the sequence. In addition, all the methods in the Method 
column of the sequence table have to be available.

To perform migration, 

start the Sequence Container Migration from the Sequence menu in Data Analysis 
view.

Figure 28 Sequence Container Migration

Fill in the following required fields (see Figure 28 on page 111): 

Select Sequence Template: Select the sequence file .S that contains the sequence 
table that matches the data set to be migrated. 

Select Method Patch: Select the directory where the methods are located that 
are referenced in the sequence table. 

Select Source: Select the directory that contains the data files to be migrated. 
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Select Destination: Specify the path and name of the sequence container to be 
created. You may select an existing folder or create a new one. 

When all fields are filled in, the migration can be started. 

The following steps will be performed:

• The sequence container directory will be created.

• The sequence template will be copied to the container. It will also be 
converted to a state where it is able to reprocess data files in Data Analysis 
view.

• The methods referenced in the sequence table are copied from the specified 
method path to the container folder.

• The data files, the sequence logbook, and the batch file are copied from the 
data source directory to the destination directory.

• According to the information in the sequence table, a copy of the 
corresponding method is copied to each data file as DA.M.

When the container migration is completed, a success message is displayed in 
the Messages and Warnings field. Otherwise a warning message indicates any 
problem during migration. Details about the warning can be obtained by 
double-clicking the warning message.
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Conversion of Data Migrated from ChemStore

When ChemStore sequence data have been migrated to ECM, they are already 
available in the form of .sc.ssizip files and thus ready to be downloaded into 
ChemStation Data Analysis view. However, such sequence containers have to 
be converted to be ready for review in the Navigation Table.

The conversion process is started automatically after downloading the data 
from ECM:

1 Select ECM > Load Data and select the data set you want to view in 
ChemStation.

A message is displayed that the sequence data will be reprocessed. Press Yes 
to continue. 

2 When asked to save the sequence file, press Yes.

In order to prevent printing reports for the reprocessing step for 
conversion, the Sequence Output settings of the sequence are changed in the 
following way:

• Print sequence summary report: on
• Report to printer: off
• Report to file: off
• Report to PDF: off
• Report to HTM: off
• Print individual report for each run as well: off

3 Now you can review or reprocess the sequence data.

If the sequence container is uploaded to ECM after conversion (either 
automatically after reprocessing or manually), the new versions of the 
sequence can be loaded into ChemStation without further conversion steps 
later on.

NOTE If you press No, the local copy of the data set will be deleted immediately. 
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This chapter provides information on the integration of OpenLAB Intelligence 
Reporter in Agilent ChemStation.
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Introduction

Agilent OpenLAB Intelligence Reporter provides advanced reporting 
functions for any chromatographic data generated by Agilent ChemStation or 
Agilent OpenLAB ICM. The reports are based on the standardized ACAML 1.1 
or 1.2 data, which is automatically generated by ChemStation (B.02.01.SR1 or 
higher, with ChemStation OpenLAB Option).

OpenLAB Intelligence Reporter enables you to generate knowledge by creating 
various types of intelligent reports:

• Sequence reports with summary calculations and statistics

• Reports of complex tests with condensed information, for example by 
visualizing key results or by presenting trend charts

• Reports presenting decision-based results (for example, with flagged 
outliers, or with results automatically sorted by pass/fail criteria)

You can either use OpenLAB Intelligence Reporter to report the results 
currently shown in ChemStation, or you can define the required data in the 
Reporter Client.

ACAML version

ChemStation stores all data in the ACAML format (ACAML = Agilent Common 
Analytical Markup Language), which results in .acaml files. There is one 
.acaml file for each sequence or single run. When the data is uploaded to ECM, 
the .acaml file is part of the SSIZIP sequence container. OpenLAB Intelligence 
Reporter uses the data provided in these .acaml files.

In ChemStation B.04.02, the ACAML schema is updated from version 1.1 to 
1.2. This version 1.2. of the ACAML schema is only supported by OpenLAB 
Intelligence Reporter revision A.02.01.

NOTE For more detailed information on OpenLAB Intelligence Reporter, please see the OpenLAB 
Intelligence Reporter documentation.
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Data flow - example

When using ChemStation together with ECM and OpenLAB Intelligence 
Reporter, data is transferred at different times from the ChemStation client to 
the ECM Server and back. There are several possible scenarios for the data 
flow, depending on the workflow you follow. 

As an example, the following figure shows the data flow for creating a single 
sequence report.

Figure 29 Example: Data flow for creating a single sequence report

1 In ChemStation:

• You select a report template for the OpenLab Intelligence Reporter in the 
Sequence Output.

• If the report is to created automatically at the end of the sequence, you 
select Preview at end of sequence in the Sequence Output.

• You select the Automatic Data Transfer Setting After Acquisition.

• You start the sequence.

2 After the acquisition, all data is automatically transferred to ECM.

3 The result data and metadata is automatically extracted from the .acaml 
files into the Reporting Database. 

4 In ChemStation: You trigger the creation of the report by clicking Create 
OpenLAB Intelligence Report. If  Preview at end of sequence was selected in the 
Sequence Output, the report is created automatically without additional 
user interaction.
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5 The previously selected report template is automatically applied to the new 
sequence data. The resulting report is transferred to the ChemStation client 
computer.

6 The resulting OpenLAB IR report is shown in ChemStation.

Prerequisites

If you want to use OpenLAB Intelligence Reporter, the following prerequisites 
must be met:

• OpenLAB ECM is installed.

• OpenLAB Intelligence Reporter is installed.

• ChemStation OpenLAB Option is installed.

• The chromatographic data has been uploaded to ECM.

Typical reporting workflows

Depending on the scenario, there are different workflows when working with 
OpenLAB Intelligence Reporter. Typically one of the following workflows 
applies:

• Single Sequence OpenLAB Summary Report (see “To create a Single Sequence 
OpenLAB Summary Report” on page 123)

A single sequence is acquired in ChemStation, and the data is reviewed in 
ChemStation first. The OpenLAB summary report is created for this single 
sequence only.

• Multiple Sequence Summary Report

Multiple sequences are acquired over time (days to weeks). A user 
subsequently searches for these sequences, and creates a summary report 
for the selected sequences.

• Study/Project Summary Report

A large number of sequences (10’s to 100’s) are acquired over time (weeks 
to months). A user searches for all data for these sequences and creates a 
complex study summary report based on these data.
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Example reports

The reports generated by OpenLAB Intelligence Reporter can include a wide 
variety of information, such as:

• Custom calculations (e.g. summary calculations, statistics, and complex 
tests)

• Decision-based result presentation (flag outliers, automatically sort results 
by pass/fail criteria, etc.)

• Search-based report content selection

• Condense information by visualizing key results (e.g. in trend charts)

In addition, interactive reports can be based upon specific parameters, such 
as a date range, or the reports can contain expandable detail information. 

See the following figures as an example.

NOTE Only the Single Sequence Summary Report can be directly generated from ChemStation. 
For the other two reporting workflows, you need to perform all tasks in OpenLAB 
Intelligence Reporter. See the OpenLAB Intelligence Reporter documentation for more 
details.

NOTE When printing an Intelligence Report directly in the ChemStation only a report based on the 
latest version of the data can be created. For reports based on earlier versions the report 
template has to be modified, or the report has to be created in the OpenLAB Intelligence 
Reporter software.
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Figure 30 Multi-sequence summary report 

(1) Report header with company logo

(2) Sequence information

(3) Sequence table

(4) Results for calibration standards
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Figure 31 Interactive column usage report

(5) Statistical calculations

(6) Results for quality control samples, grouped by sample name

(1) User parameters (here: Start Date and  End Date) as selected by the user

(2) Expandable detail information
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Figure 32 Cross sequence statistics with trend chart

(1) Expandable detail information on each sequence

(2) Overall statistics

(3) Trend chart
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To create a Single Sequence OpenLAB Summary Report

1 Prepare the data in ChemStation. There are different ways of preparing the 
data (see “Data-related workflows” on page 59). For example, run a 
sequence with the Transfer Setting After Acquisition.

2 In the Data Analysis view, load the relevant data set.

3 Under Sequence > Sequence Output, select a suitable OpenLAB IR template.

4 Select ECM > Create OpenLAB Intelligence Report.

The resulting OpenLAB IR report is opened with the data of the current 
sequence.

NOTE Make sure the data has been uploaded to ECM.
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Interface Components Concerning OpenLAB IR

If OpenLAB Intelligence Reporter is installed, several new interface 
components are available in ChemStation. These components are described in 
the following.

Template selection in Sequence Output

Under Sequence > Sequence Output, you can select an OpenLAB Intelligence Report 
Template for the currently loaded sequence. This setting is optional.

• If you select a specific report template:

When you create a report, OpenLAB Intelligence Reporter automatically 
uses the given report template. The resulting report is shown in OpenLAB 
Intelligence Reporter without any further inquiry.

• If you do not select any specific report template:

When you create a report, OpenLAB Intelligence Reporter opens with the 
relevant data already selected, but without applying any specific report 
template to the data. You must open a suitable report template manually in 
the OpenLAB IR Reporter Client. 

Depending on the options selected in the OpenLAB IR Reporter Client, the 
report is either generated automatically after loading the template or must be 
generated manually. 

The link to the selected report template is stored in the sequence parameters. 
Thus, when you create the report the next time, the report template will be 
automatically applied.

NOTE On an ECM installation with multiple accounts, projects from all accounts are visible in the 
Projects menu of OpenLAB Intelligence Reporter! Ensure that you select a project 
belonging to the ECM Account you are working on.

This is not an issue when selecting a template directly from ChemStation, as you select the 
template from the LCDF structure of the specific ECM Account you are working on.
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You can select a different report template in OpenLAB Intelligence Reporter at 
any time. The setting in the Sequence Output in ChemStation is only used as a 
default setting. 

Automatic Creation of OpenLAB Intelligence Report at the End of 
the Sequence

Under Sequence > Sequence Output, you can select Preview at end of sequence for 
the currently loaded sequence template. This setting is optional. It requires 
that an OpenLAB Intelligence Report Template is also selected.

With this setting enabled, the OpenLAB Intelligence Report will be created 
automatically at the end of sequence acquisition or sequence reprocessing 
based on the selected template.

OpenLAB IR commands in the ECM menu

In the ECM menu, there are two commands related to OpenLAB Intelligence 
Reporter:

• Start OpenLAB IR

This command opens OpenLAB Intelligence Reporter. No data is 
passed from ChemStation to the Reporter Client. You can select the 
required data directly in the Reporter Client.

• Create OpenLAB IR Report

After acquiring or reprocessing sequence data, you can create a 
report in OpenLAB Intelligence Reporter as soon as the data has been 
uploaded to ECM. The report is based specifically on the current sequence, 
that is, the sequence that is currently loaded in the Data Analysis view in 
ChemStation.

NOTE You must first upload the sequence data to ECM before you create a report. Only data that 
is available in ECM can be used by OpenLAB Intelligence Reporter to generate a report.



126 ChemStation OpenLAB Option Concepts Guide

8 Interface to OpenLab Intelligence Reporter
Interface Components Concerning OpenLAB IR

Calculation of performance values

In ChemStation, certain specific values, such as noise and peak performance 
values, are not necessarily calculated and uploaded to ECM. If these values are 
not uploaded to ECM, you can not use them in your reports.

Under ECM > Preferences, there is the check box Calculate Peak Performance. This 
check box is cleared by default.

• If you select Calculate Peak Performance:

Values such as noise and peak performance values are always calculated. 
They are uploaded to ECM together with the other sequence data. You can 
use the values in your reports.

• If you do not select Calculate Peak Performance:

Values such as noise and peak performance values are only calculated if 
you choose the ChemStation report styles Performance or Extended 
Performance. As a consequence, there is no guarantee that these values 
always exist in ECM, and you can not generate reliable OpenLAB IR reports 
containing this type of information.
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This chapter provides an overview of the available ECM Attribute Extraction 
Services (AES) for ChemStation data. The AES extract metadata information 
from the ChemStation data files. These metadata make the ChemStation data 
searchable. For detailed information, refer to the ECM documentation.
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Attribute Extraction Services for ChemStation Data

ECM Attribute Extraction Services (AES) provides the following AES for the 
extraction of metadata from ChemStation data files:

• The ChemStation XML filter extracts peak, compound and result data from 
the result.xml file generated by the XML export routine in ChemStation 
revision A.10.02 and later.

• The ChemStation filter extracts basic sample and run data from the header 
of the channel files (*.ch), *.uv and *.txt files generated by all ChemStation 
revisions.

AES need to be installed by an ECM Administrator on the ECM Server; in 
addition, the filters need to be enabled for the system. The keys of an AES that 
are to be applied to a ChemStation file need to be selected for the respective 
LCDF structure. These are ECM administration tasks, and are described in the 
Enterprise Content Manager Administrator’s Guide and the ECM online help.

The metadata can be queried using various search types in ECM. The ECM 
Search functionality is also available within ChemStation. When opening a file 
from ECM, the ECM Open dialog allows you to search for files of interest using 
the ‘magnifying glass’ icon, see Figure 33 on page 129.

Using the Quick Search, you can search through various alphanumeric fields 
by entering a search key, such as an operator name. On the upcoming search 
page, you select the Advanced tab where, depending on the enabled filter 
packages, various keys are enabled, see Figure 34 on page 129.
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Figure 33 Search options

Figure 34 Filters available in search options

In the Search dialog, you can specify the available keys, and it is possible to 
define a search expression by combining two or more of the available keys 
using boolean operators. For detailed information regarding the use of the 
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various search algorithms, refer to the online help of your ECM system or the 
Enterprise Content Manager Administrator’s Guide, as well as the AES-related 
manuals.
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ACAML Filter

The ACAML Filter extracts information from the ACAML files that are also 
used for the OpenLAB Intelligence Reporter (see “Interface to OpenLab 
Intelligence Reporter” on page 115. The ACAML files are always created when 
acquiring or reprocessing data when the OpenLAB Option is installed. 

Please note that the ACAML filter is only available for ECM 3.3.2 SP1.
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ChemStation XML Attribute Extraction Service

The AES for ChemStation XML extracts key information from the following 
categories of the result.xml generated by ChemStation Rev. A (revision A.10.02 
and later) and ChemStation Rev. B (revision B.01.01.and later) per data file. 
Note that ChemStation must be configured to generate the result.xml file, see 
the ChemStation XML Connectivity Guide. 

• Acquisition (for example, instrument name, method information)

• Chromatogram (for example, derivative order, detector name)

• Custom

• Module

• Peaks (for example, peak name, amount, retention time, compound name)

• Sample (for example, calibration method, LIMS ID)

• Signal/noise
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ChemStation Filter

The AES for ChemStation extracts attributes from *.ch, *.uv, and *.txt files 
created by the 16-Bit ChemStation (Rev A.x.x) or 32-Bit ChemStation (Rev 
B.x.x). It extracts key information from the header of ChemStation *.ch and 
*.uv data files (for example, sample name, method file, instrument model). 
From the report.txt file, it extracts key information (for example, sample 
name, acquisition method, analysis method). In addition, the service extracts 
information on support files from the category Content.

An ECM Scheduler Add-in for Agilent ChemStation enables the ECM 
Scheduler to automatically upload data generated by ChemStation to ECM.
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This chapter gives a brief overview of how to install and configure the Print 
Services. This enables you to automatically upload ChemStation reports to 
ECM in a PDF format.
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ECM Print Services

ECM Print Services are print management systems that transfer human 
readable electronic documents to ECM. They can be used to print ChemStation 
reports to ECM in PDF format.

When you add and configure a print service, it appears as an available printer 
on your computer. When you print with ECM Print Services, a PDF file is 
created and automatically uploaded to the ECM system. In addition, you can 
also set up the system to print additional hard copies to a conventional 
printer.

ECM Print Services can be installed for ECM Server revision 3.3.1 or later.

The ECM Print Service consists of two components:

• The ECM Print Service Manager, where you add and manage printers for 
the ECM Print Service.

• The ECM Print Service, which monitors a folder on your local disk drive. 
When a print service receives a print job, the print driver prints to a file in 
the monitor folder. Then the ECM Print Service intercepts the file and 
uploads it to ECM. In order for a file to be uploaded to the ECM program, it 
must have the file extension *.pdf.
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Setting Up ECM Print Services

Installing ECM Print Services

The installation and setup of ECM Print Services requires following steps. The 
installation details are given in the ECM Print Services documentation.

1 Connect to the ECM Server revision 3.3.1 and select the Administration tab.

2 In the Download section of the Administration tab, select ECM Print Services for 
ECM and run the installation. Follow the instructions given by the 
installation wizard.

3 After the installation, the ECM Print Services icon is available in the task 
bar and the Amyuni PDF Convert is available as printer (see Start > Settings 
> Printers and Faxes > Amyuni PDF Converter).

4 Double-click the ECM Print Services icon. The ECM Login dialog opens.

5 Enter the required user credentials and click Login to proceed for 
configuration.



138 ChemStation OpenLAB Option Concepts Guide

10 Using Print Services in ChemStation
Configuring ECM Print Services for use with Amyuni PDF Converter

Configuring ECM Print Services for use with Amyuni PDF 
Converter

1 Create a monitor folder on your ChemStation ECM Client system. The 
folder should not be placed in the Chem32 directory.

2 Right-click the ECM Print Services icon in the task bar and select Configure 
Printers.

Figure 35 ECM Print Service icon

3 Log on to the ECM Print Services.

4 Select the Add Printer icon to add a printer with the following details:

• Type: PDF Converter

• Name: Specify a unique name, e.g. 
Chem1 Print

• Define the printer security options in accordance with your 
organization’s security policies.

5 Click Add to continue. Depending on your PC configuration, a message 
regarding the Browse for Folder dialog is shown. Exit that message with OK.

6 In the upcoming Browse for Folder dialog, select the monitor folder for the 
ECM print service.

7 The printer has now been created successfully and is available in the ECM 
Service dialog.

8 Right-click the ECM Print Service icon in the task bar and select Configure 
Printers, see Figure 35 on page 138.

9 Open the printer configuration by marking your specific printer and select 
the Configuration tab. For details, refer to the ECM Print Services online 
help.

• ECM: you need to specify the ECM (LCDF) data path where the uploaded 
files will be stored after transfer.

• Settings: Transfer-specific settings.
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• Hardcopy Printers: It is also possible to get a hardcopy printout.

• Email: It is possible to enable e-mail notification.

10 Click Apply to apply the configuration to the ECM Print Service and leave 
the dialog box with OK.

11 Leave all printer-related dialog boxes with OK.

12 In ChemStation, it is now possible to specify the newly configured printer 
in the File pull-down menu under Printer set up. It is possible to select the 
ECM Print Service as specific printer; if the printer has been marked as 
default printer in the Windows Settings, it will be already defined as default 
printer in ChemStation.

To set the printer to ‘unattended mode’

Typically, when you print to an ECM Print Service, a dialog box asks you to 
confirm the upload location in ECM as well as some other settings for each 
report. If you are planning to print a whole sequence of reports, you can 
confirm these settings once for the series and than run the printer in 
unattended mode for a specified time. The duration of the unattended mode is 
set in the Configuration of the ECM Print Service during setup, but can be 
modified at any time. 

1 Right-click the toolbar icon ECM Print Service and select Login Printer 
Unattended.

Figure 36 Define Logon for Print Service

2 Select the printer that you want to operate in unattended mode.

3 Confirm the job settings once and click OK.
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Configuring ECM Print Services - Adobe Distiller 

1 Create a monitor folder on your ChemStation computer. The folder should 
not be placed in the Chem32 directory.

2 Select the Add Printer icon to add a printer with the details:

• Type: Adobe Distiller

• Name: Specify a unique name, e.g. Chem1 Print

• Define the printer security options in accordance with your 
organization’s security policies.

• In the upcoming Add Port dialog, choose Add Port and select the specified 
monitor folder on the ChemStation computer.

3 Click Add to continue and browse for the monitor folder for the ECM print 
service.

4 Open the printer configuration by marking your specific printer and select 
the Configuration tab.

• ECM: you need to specify the ECM data path where the uploaded files will 
be stored after transfer.

• Settings: Transfer specific settings.

• Hardcopy Printers: It is also possible to get a hardcopy printout.

• Email: It is possible to enable e-mail notification.

5 Click Apply to apply the configuration to the Print Service and leave the 
dialog box with OK.

6 Depending on the Acrobat Distiller version in use, additional configuration 
settings are necessary. A message requests you to perform certain tasks.

Example for Adobe Distiller Rev. 6.00:

In Start > Settings > Printers open the properties of the newly added printer. 
Select Print Preferences.

• In the Adobe PDF Conversion Settings, deselect View Adobe PDF results.

HINT For details, refer to the ECM Print Services online help.
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• In the Adobe PDF Output Format, select the monitored path of the 
ChemStation computer.

• Select Edit for the default settings. On the upcoming Adobe PDF Settings 
dialog, deselect  optimize for fast Web View and save the settings.

7 Exit all printer-related dialog boxes with OK.

8 In ChemStation, it is now possible to specify the newly configured printer 
in the File pull-down menu under Printer set up. It is possible to select the 
ECM Print Service as specific printer; if the printer has been marked as 
default printer in the Windows Settings, it will be already defined as default 
printer in ChemStation. 

To set the printer to ‘unattended mode’

Typically, when you print to a Print Service, a dialog box asks you to confirm 
the upload location in ECM as well as some other settings for each report. If 
you are planning to print a whole sequence of reports, you can confirm these 
settings once for the series and than run the printer in unattended mode for a 
specified time. The duration of the unattended mode is set in the 
configuration of the ECM Print Service during setup, but can be modified at 
any time.

1 Right-click the ECM Print Services toolbar icon and select Login Printer 
Unattended, see Figure 36 on page 139.

2 Select the printer that you want to operate in unattended mode.

3 Confirm the job settings once and click OK.



142 ChemStation OpenLAB Option Concepts Guide

10 Using Print Services in ChemStation
Working with ECM Print Services in ChemStation

Working with ECM Print Services in ChemStation

When you use the ECM Print Service in ChemStation, any report printed using 
the Print Services is converted to a *.pdf file, placed in the monitored folder, 
and transferred by the print service to the specified location in ECM. During 
conversion to PDF, the name supplied by the system is fixed. It is defined as 
follows:

• single runs: [datafile name].pdf

• sequence runs: [sequence name]_ [datafile name].pdf

• sequence summary reports: SSR_[sequencename].pdf

The maximum file length for this automatically generated report name is 30 
characters; longer files names are truncated. If, due to the truncation, 
filenames are the same, the existing file is overwritten.

NOTE Be aware that when you specify the sequence pattern and datafile name in the sequence 
setup, the complete *.pdf file name may not exceed 30 characters.
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The chapter gives some elementary troubleshooting hints.
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General Problems

ECM Server is not Available

If the ECM Server is not available while working with ChemStation, there are 
two possible scenarios.

ECM Server is not available before/during login

If the ECM Server is not available while logging in to ECM from ChemStation, 
the user cannot be authenticated by the ECM system. Login is aborted and 
there will be no access to the ECM functions in ChemStation; all ECM-related 
menu items will be grayed out.

For further troubleshooting, please contact your ECM administrator.

ECM Server is not available after login

If the ECM Server connection is interrupted after login to ECM from 
ChemStation, the user has been authenticated by the ECM system. In this case, 
ChemStation knows the current logged-in user.

When the ECM Server becomes unavailable, ChemStation automatically tries 
to reestablish the user login.

The ECM Load and Save functions are accessible, but an alert informs the user 
about the interrupted connection to the ECM.

While acquiring data, the automatic transfer of data to ECM cannot be 
completed. The user is notified by an error message. and must manually 
upload the data as soon as the connection is reestablished (ECM > Manage 
Queue).

As soon as the ECM Server is available again, all ECM tasks are available 
without restarting the application. A new login is not required.

For further troubleshooting, please contact your ECM administrator.
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Alerts and Error Messages at ChemStation Startup

Your Transfer Settings/Remote Data Path seems to be set to default

At every startup, Agilent ChemStation checks whether all necessary 
information is provided for transferring data to ECM. This message is shown if 
the Remote Data Path is not set or is incomplete.

Probable cause Suggested actions

1 The Remote Data Path is not set or is 
incomplete.

Make sure that the information on ECM Server, 
ECM Account, and a complete LCDF path is 
provided in the Transfer Settings (ECM > 
Preferences > Transfer Settings).
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Error Messages in the Spooler Queue Manager

Account Mismatch

Host Mismatch

The queue already contains items

Invalid license ID or license has expired.

Probable cause Suggested actions

1 Account setting in Preferences differs from 
current connection (or offline).

Correct the Transfer Settings and connect to 
ECM.

Probable cause Suggested actions

1 ECM Server in Preferences differs from 
current connection (or offline).

Correct the Transfer Settings and connect to 
ECM

Probable cause Suggested actions

1 There are items in the queue that have been 
queued before the current item.

Process queue in the correct order. If necessary, 
export items that can't be resolved.

Probable cause Suggested actions

1 Server license timeout. Log out and log in again.
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You do not have permission to create a new Drawer/Folder.

You do not have permission to add files. 

Unable to upload (filename). This file is currently checked out to 
another user and may not be updated. (error -1).

Probable cause Suggested actions

1 You do not have appropriate privileges to 
create the Drawer or Folder.

Ask an administrator to give you the 
corresponding privileges or to create the needed 
directories.

Probable cause Suggested actions

1 You do not have appropriate privileges to 
save files to the specified location in ECM.

Ask an administrator to give you the 
corresponding privileges.

Probable cause Suggested actions

1 Another user has checked out the file. The other user has to check in the file before 
you can upload the file.
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ChemStation Privileges in ECM

Privilege Description

CS: Audit Trail Run: Enable the audit trail for a specific method

CS: Batch Run: Enables all operations in Batch view

CS: Break Session Lock Run: Unlock a ChemStation session locked by 
other users

CS: Calibration Edit: Create and modify the calibration table; 
change calibration settings

CS: Command Line Run: Turn on / off the command line

CS: Companion View: Access to Companion view (GC 
ChemStation only)

CS: Control View: Access to Method and Run Control view

CS: Data Edit: Interactive saving of data to ECM
Delete: Delete data files in ChemStation 
Explorer

CS: Data Analysis Run: Access to Data Analysis view

CS: Diagnostic View: Access to Diagnosis view

CS: Full Menu Run: Enable the ChemStation Full Menu

CS: Instrument Configuration Edit: Modify instrument configuration 
parameters 

CS: Instrument Setup Edit: Modify instrument method parameters 

CS: Integration Events Edit: Modify Integration Events + perform Auto 
Integration

CS: Ion Labels Edit: Edit options for Ion Labels (LC/MS-only)

CS: Logbook Edit: Save the current logbook
Delete: Clear the current logbook
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CS: Manage Transfer Queue Run: Access to the following items of the 
Spooler Queue Manager
• Save selected item locally
• Delete selected item
• Properties

CS: Manual Integration Run: Perform manual integration

CS: Method Edit: Save method changes (includes Update 
Sequence/Master Method in Data Analysis 
view)
Delete: Delete a method in ChemStation 
Explorer

CS: Method Properties Edit: Modify Run Time Checklist and Method 
Information

CS: Print Report Run: Print/preview a report

CS: Recalibration Run: Perform interactive recalibration

CS: Report Edit: Modify report calculation/print style +edit 
Instrument Curves dialog

CS: Report Layout View: Access to Report Layout view

CS: Report Template Edit: Save a report template

CS: Reprocess Run: Reprocess a sequence

CS: Retention Time Lock Edit: Access to the Retention Time Lock menu 
(GC only)

CS: Retention Time Search Edit: Access to Retention Time Search menu 
(GC only)

CS: Run Run: Start acquisition (single sample or 
sequence)

CS: Sequence Edit: Save sequences
Delete: Delete sequences in ChemStation 
Explorer

CS: Sequence Summary Edit: Modify sequence summary report and 
extended statistics settings

CS: System Suitability Edit: Edit noise ranges and performance limits 

Privilege Description
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CS: Transfer Preference Edit: Edit the Transfer Settings in the 
Preferences

CS: Tune View: Access to Tune view (LC-MSD 
ChemStation only)

CS: Verification View: Access to Verification (OQ/PV) view

Privilege Description
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ChemStation Roles in ECM

Please note: the default ChemStation roles do not contain any ECM privileges.

Table 3 Default CS Administrator privileges

Privilege View Edit Delete Add Run

CS: Audit Trail X

CS: Break Session Lock X

CS: Command Line X

CS: Control X

CS: Data X X

CS: Data Analysis X

CS: Diagnostic X

CS: Full Menu X

CS: Instrument Setup X

CS. Logbook X X

CS: Manage Transfer Queue X

CS: Manual Integration X

CS: Method X X

CS: Method Properties X

CS: Print Report X

CS: Report Layout X

CS: Report Template X

CS: Sequence X

CS: Transfer Preferences X
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Table 4 Default CS Analyst privileges

Privilege View Edit Delete Add Run

CS: Batch X

CS: Calibration X

CS: Control X

CS: Data X

CS: Data Analysis X

CS: Full Menu X

CS: Instrument Setup X

CS: Integration Events X

CS. Logbook X

CS: Manual Integration X

CS: Method X X

CS: Method Properties X

CS: Print Report X

CS: Recalibration X

CS: Report X

CS: Report Layout X

CS: Report Template X

CS: Reprocess X

CS: Run X

CS: Sequence X X

CS: Sequence Summary X

CS: System Suitability X
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Table 5 Default CS Lab Manager privileges

Privilege View Edit Delete Add Run

CS: Audit Trail X

CS: Batch X

CS: Break Session Lock X

CS: Calibration X

CS: Command Line X

CS: Companion X

CS: Control X

CS: Data X X

CS: Data Analysis X

CS: Diagnostic X

CS: Full Menu X

CS: Instrument Configuration X

CS: Instrument Setup X

CS: Integration Events X

CS. Logbook X X

CS: Manage Transfer Queue X

CS: Manual Integration X

CS: Method X X

CS: Method Properties X

CS: Print Report X

CS: Report X

CS: Report Layout X

CS: Report Template X

CS: Reprocess X

CS: Run X
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CS: Sequence X X

CS: Sequence Summary X

CS: System Suitability X

CS: Transfer Preferences X

CS: Tune X

CS: Verification X

Table 6 Default CS Operator privileges

Privilege View Edit Delete Add Run

CS: Control X

CS: Data X

CS: Print Report X

CS: Run X

CS: Sequence X

CS: Sequence Summary X

Table 5 Default CS Lab Manager privileges

Privilege View Edit Delete Add Run
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ECM related privileges concerning the ChemStation 
configuration

The privileges described in the following table must be assigned to at least one 
of your roles in order to become active.

Table 7 List of ECM related privileges

Privilege View Edit Delete Add Run Description

Content: File X X • Minimum privilege for ChemStation 
to access ECM

• Privileges to view ECM Properties in 
ChemStation

Content: File Filtering X • Minimum privilege for ChemStation 
to access ECM

• Privilege to add files manually to an 
ECM folder

Content: File Revisions X • Privilege to view revisions in 
ChemStation

Content: File Type [XLS] X X • Privilege to add and check in files 
with an .xls extension

Content: Folder X X X • Minimum privilege for ChemStation 
to access ECM

• Privilege to view ECM Properties in 
ChemStation

Content: Folder Access 
Properties

X • Privilege to view and change any 
folder property tab

Content: Rekey File X • Privilege to rekey files in ECM e.g. 
with XML Filters

System: Advanced Search X • Privilege to use the Advanced 
Search in ChemStation

System: Audit Trail X • Privilege to view ECM Properties in 
ChemStation
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System: Filtering 
Configuration

X • Privilege to view or change the 
filtering configuration

• Privilege to use attribute extraction 
services and to manage 
user-defined attributes

System: indexing 
Configuration

X • Minimum privilege for ChemStation 
to access ECM

• Privilege to view ECM Properties in 
ChemStation

System: Quick Search X • Privilege to use Quick Search in 
ChemStation

System: Super Object X • Privilege is mandatory for OLIR

System: Project X • Privilege to view projects in OLIR

System: Project Access X • Privilege to access projects in OLIR

Table 7 List of ECM related privileges

Privilege View Edit Delete Add Run Description
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